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SAi Box&Display powered by Flexi  

Overview 

SAi Box&Display eliminates multiple steps to improve job creation efficiencies and simplify the structural 
design of folding carton, corrugated plastic and rigid honeycomb material POP and free-standing display 
units, as well as packaging. 

 

SAi Box&Display is compatible with all existing wide-format RIP software that drives flatbed printers and 
cutters and features a simple, yet complete toolset to enable easier display and box structure design. 
Powered by the company's renowned Flexi software, SAi Box&Display features an extensive library of 
continually-expanding display and box templates. This allows print providers to quickly choose and 
personalize these to meet their client's exact specification. Using SAi Box&Display 's intuitive interface, 
designers can enter new geometric values, from which the SAi Box&Display software then parametrically 
rebuilds designs in seconds. 

Further cost- and time-saving benefits are provided by an integrated graphic and structural design with 
animated 3D folding preview, which helps maintain workflow efficiency by catching any mistakes before 
production. This is also aided by the ability to export rotational package display or box designs as 3D PDF 
files, for customer review prior to production. As a result, SAi Box&Display overcomes the troublesome 
pain-points faced by designers when creating such pieces in their existing third-party software. 

Help Documentation Flexi is the CAD platform on 
which all of the shapes are created and SAi 
Box&Display [BD] is the 3D Parametric Design and 
Rendering Engine that allows for templates to be used 
and manipulated. SAi Box&Display works in 
conjunction with Flexi to create the related contours 
on screen after which the files are created and saved. 
The saved files include both Flexi and SAi Box&Display 
data that allows the file to be converted into a template at any time by opening it in BD.  

Since Box&Display works in conjunction with Flexi to create the related contours on screen, there is 
separate documentation available. To learn about the drawing and design tools of Flexi, read the Flexi 
Help Topics [F1] 

This manual, SAi Box and Display User Guide, will help you to learn about Box&Display. BD allows you 

to use existing templates which you can easily modify to your requirements. So, the first topic addressed 

in this manual is how to do this. 
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What it does and how it works 

SAi Box&Display is a 3D design software package for boxes and POS displays. It is based on pre-defined 
templates and is mainly intended for production on large-format inkjet printers and digital cutting tables. 

SAI is a US-based software developer, specialising in RIPs and related production software for large-format 
printers and CNC routers. SAi Box&Display includes components from SAI’s Flexi signage design software, 
which allows artwork to be added to box and display item templates. 

SAi Box&Display is efficient because its all-in-one structure eliminates multiple steps. It can quickly create 
and apply artwork to the structural design of folding carton, corrugated cardboard and sandwich material 
POS for free-standing display units. 

 

 

Extensive library of easy-to-adjust POP-display and box templates 

SAi Box&Display allows for the creation of digital flat artwork onto items from a library of pre-defined folding 
carton, POS and display templates. 

Since the design of a functional package or POS is quite intensive, it is recommend using and modifying 
existing templates. Users can, however, create their own templates if a user has the inclination, as the tool 
is quite powerful and can be used to create virtually any type of package or POS display. 

The “hundreds” of box and display templates supplied include items from ECMA (European Carton Makers 
Association) and FEFCO (the European Federation of Corrugated Board Manufacturers). Templates include 
multiple pieces where relevant, with tools to add features such as ex Design features include vector and 
bitmap tools and include effects such as shadows and gradients, and for the creation of masks, outlines, etc. 
White, varnish and metallic channels are supported and variable text can be specified. Objects can also be 
nested for efficient layout on the printer. 

The templates align to 3D CAD models so designs can be applied to these and previewed in 3D. Integrated 
graphic and structural design, with animated 3D folding preview, helps maintain workflow efficiency by 
catching any mistakes before production. 3D files can also be exported as PDFs that can be sent to customers 
for approval. 

After approval, the files can be sent to any RIP, not just SAI’s. There are no drivers or hardware-specific 
features needed. 
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Flexi and Box&Display - Basic Elements 

The illustration below shows some of the basic elements of your software. Note that the Box&Display icons 

may vary in position to the image below, position of which can be change to suit user preference. 
 

Flexi* is the CAD platform on which all of the shapes are created and works in conjunction with Box&Display 

which is the 3D Parametric Design and Rendering Engine that allows for templates to be used and 

manipulated.  

* For more details on how to use Flexi, see the Help Topics available from Main Menu or F1. 
 

 

The Box&Display Interface 
To access the Box&Display interface you need to start a new Box and Display project. 

From the Flexi toolbar, you have two choices.  

(1) Start a ‘New’ Free Form design from scratch  
Discussed in Chapter 6 and Chapter 7 

or  
(2) Start a new design from a template. 

Discussed in Chapter 1  

The View  button is used to Open/View a box you have created. If the other two icons shown are greyed 

out as a result, the Ctrl+N [  or File>New ] will present these again for selection. 

Specifications 

Platform  PC running Windows 7 to 10 (16 or 32-bit) 

Input file formats Include PDF, AI, EPS, JPEG, TIFF and PNG 

PDF Viewer  Free Adobe Acrobat Viewer required for Export 3D 

Design tools Include raster and vector elements, with support for white, clear and metallic 
channels 

Output file formats Include PDF, AI, PSD, JPG and TIFF 

Compatibility  Works with any printer RIP or cutting software. 
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Chapter 1: Template - Create a Box/Display  

The most efficient way to create a new box or display is to start from an existing template and this section 
will discuss the basics on how to do this. Tutorials are provided later in this manual.  

On the Flexi toolbar, clicking on the lightning bolt  button will allow you to use existing templates 
which can quickly and easily be modified to meet your requirements.  

Watch the short video to get a quick overview of what will be discussed in this chapter. 

 How to Create a Corrugated POP Display in Seconds Using Box and Display  

NB: Internal hyperlinks have been added to allow you to locate more detailed instructions on a topic.  

Just use the following shortcut commands … 

➢ Ctrl+Click to follow internal link to quickly navigate to other parts of this document. 

➢ Return from a hyperlink jump by using Alt+left-arrow   Acrobat Reader required for this option. 

Create a Box/Display from a Template with No Graphics 

Here is the process for creating a new box from a template using just the Friendly Page controls: 

Tutorial Video  Starting New Project 

1. Open a new Box&Display file by clicking on the lightning bolt  button. 

2. Use Catalog to identify the box to be cut. 

3. Select the Standard Library to display the list of Box&Display templates.  

• Double click the desired Template from the Box Library or click, to select, and click ‘Create’. 

Suggestion: Select a FEFCO 0205 which is a simple box – See Tutorial 200 Step 1  

 NB: Box Wizard is available for selection here and will be discussed at the end of this chapter. 

4. A dialog box, called a Property Inspector, is displayed 

for the selected template. Shown is the related 

Friendly Page. 

5. Radio buttons for View Options allow you to select 

how your template is displayed. Default is 2D. 

Edit Options can be used to make required adjustments. 

6. Click Materials .  

• Enter your Material Thickness  

• Make any other necessary material variable 
adjustments.   

7. Click Dimensions.  

• Use the provided entry boxes to set the primary box dimensions for the box that is being created.   

8. Flaps, slots and tabs can be adjusted as required.  

9. Now click the 3D View and a ‘Play’ button will be displayed 

• Click ‘Play’ to simulate the folding of the box ensure that the box fits together properly.   

• A 3D PDF of the finished box can be created using this utility. 

https://www.youtube.com/watch?v=GbRLKmuuSH4
http://www.printtocut.com/gettingstarted/1_Starting%20A%20New%20Project.mp4
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10. Click Send to Flexi – the box will now appear as contours in flexi.   

• There are different colors, which represent different layers/cut operations.   

❖ Green lines are fold lines – See Tutorial 202 Toolpath and Fold Lines 

❖ Red lines are cut lines.  

11. With no graphics being added, the file is ready for export to PDF or DXF.  

• Click File > Export and export the file, making sure to specify the desired file export format.   

❖ These files can be brought into whatever solution is used to output files to the CNC cutter, 

be that a CAD/CAM software or directly to the machine controller, depending on the 

machine.  

FLEXI CUSTOMERS  

If you have SAi Flexi Software, you can use Production Manager from your Flexi to send 
the cut files to your CNC cutting device.  

Another option is to File > Save in Box&Display as an FS file, and then open the saved file 
into Flexi for sending to the cutter.  

ENROUTE CUSTOMERS 

If SAi EnRoute software is being used to drive your CNC cutting machine, you can use the 
DXF file format to bring the Box&Display files into EnRoute.   

Another option is to use the Send to EnRoute icon to send the files to EnRoute if both 
programs, EnRoute and Box&Display, are located on the same machine. 

 

Floor and Shelf Displays 

In Box&Display there are many variations available and the following tutorials discuss other options and 

settings which are relevant to specific templates… 

➢ Tutorial 201 Shelves - X017 Clinton FSU  

This Floor Stand Unit tutorial looks at ability to configure settings such as size, number of shelves, 

support rods and some additional style options. 

➢ Tutorial 203 Shelves - Sloped Shelf Displays 

➢ Tutorial 206 Furniture - Modern Shelf Unit 

➢ Tutorial 207 Furniture and Stands which discusses the X062 Dillion Table 

 

DXF Cutouts Displays 

A DXF file is a file format understood by many 
graphical packages and is generated to send to 
your machining software.  
 
➢ Tutorial 204 discusses how to use supplied DXF files (e.g. Swan.dxf) and how to create your own. 

➢ Tutorial 207 discusses supplied DXF’s to create Floor stands. 

➢ Tutorial 208 discusses use of DXF’s with box inserts. Available FEFCO 0300 to 0308, 0331, 0427  
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Adding New Machining Steps to a Created Box  
We will now use the box you created above to add Machine Steps. 

• Open/View the box you created above by clicking on the View  button. 

• Ensure that you are in Construction View 

• We will be working directly in the Preview pane on the right of the Friendly controls.  

• Select a section of the box that you want to work on by double clicking on it. This will make the 
section Active – note the section will be highlighted in light blue. 

Suggestion: Select Sec3_P_Panel as shown. 

• Left click on machine line shown by the cursor 

 and right click to display the context menu. 

Then click required action or used shortcut 
keys shown on RHS of menu e.g. N  

Machine lines are … 

• shown in red. 

• when selected, it changes to display an 

arrow  See Notes on Machine Step. 

• Note that templates will almost always have formulla controlled sections/flaps and you will 

notice a No Entry sign as above. However, this should not be an issue in this discussion.  

• From the context menu select Add Machine Step > Hole [ To use Shortcut Keys: Right Click presents 

context menu, then hit N on keyboard [Add Machine Step] and then H for Hole 

We will add a square hole. [See Tutorial 108 – Step 10 on how to make other shapes.] 

• Left click at required intervals, as shown below points 1-5, to form a square.  

Tips 

• Use Mouse Actions to Zoom In for a better view 

• Turn on Snap to Grid by left clicking on  icon located on the Status 
Bar– see Tutorial 103 – Step 3 endnotes 

o Adjust the Grid Spacing by opening dialog i.e. right click on icon. 

• To constrain the line to last point and keep straight –  

o Hold down the ‘shift’ key while creating the square. 

The 3D View shows the result. 
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Note: If you need to make adjustments to the hole e.g. line not correctly placed, you cannot simply 
‘Drag Point’ to correct. Once a step is added, unfortunately it does not check which bits of the 
section you are dragging, so any attempt to drag a vertex will require removing all formulas and 
making the section Construction View compatible – See Chapter 4 – Formula Controlled Section. 
 
Two alternatives are (1) Undo, undo, undo.... then add hole again more carefully or  

 (2) Delete hole [At Machine Step > Delete Machine Step] then add again. 

 

Flip Ups 

Flip ups are a common feature of point of sale boxes. 

This is a typical flip up here with a piece cut out of an 
adjacent section which doesn’t fold down but remains 
pointing up. 

Flip Ups are made with  

1) a perforation machine step  

Add Machine Step N > Perforation 

2) and then converting the perforated part into a flip up 

At Machine Step M > Convert to Flip-up 

See Tutorial 205 for instructions on how to achieve this.  

 

  



Chapter 1                                                                                                            Create Box/Display Using Template 
 

  
Page 15 

Adding Graphics to a Box/Display once it has been created 

Now we will illustrate the box. To do this we need to give Flexi the cutting instructions, which is a DXF in 
2D line view with cutting and creasing instructions. 

Tutorial Video  Send to Flexi 
 

1. Send to Flexi by clicking Send Box. 

Close the BD Property Inspector, 
using the top right X.  

 

2. We will now Import artwork for use 
in illustrating our box.  

3. Using the  icon on the Standard 
Toolbar, locate your artwork and 
Import as shown. 

 

4. Place artwork as required, e.g. →  

5. Then click on the eye  icon to View in SAi 
Box Display 

 
 
 

6. You will see the resulting placement of 
artwork using the 3D View Option. 

7. You can now send a PDF to your 
customer for approval by using the 
Export 3D button. 

 
 
 
 
 
 
 

 

8. The resulting PDF produced can 
be saved in the normal way. 

 
 
 
 
 
 

 

 

http://www.printtocut.com/gettingstarted/8_Send%20Box%20to%20Flexi.mp4
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Box Wizard 

Box wizard is the perfect tool for quickly designing one off 
and small runs of boxes and shipping cartons. It is fast and 
easy to use with a very intuitive interface.  

Use the lightning bolt  button to view template catalog 
and you will notice that BOX-WIZARDS is available with a 
starting template Box_01 which can be used to create your 
box and when you are finished, you can save it to your user 
library with your own naming convention. 

 
 

Description  

Optional and is typically used when you plan to save a finished box to your user library. NB: You can only 
save a box to the user library after you have pressed the Finished button. 

View Options 

2D (default) and 3D View, initially, are only available. The 3D view is great for looking at the finished 
product and to see how it is folding. Construction View is available after clicking the Finished button. 

Box Construction 

The box offered in the wizard is a simple four panel construction to create the sides with or without 
added closure flaps. The Glue flap is glued to the inside or outside of the last panel to form a four-sided 
tube. Box dimension are really straight forward. 

 

Thick  = The thickness of your material 

(A) = The width of the box 

(B) = The height of the box 

(C) = The depth of the box 

Glue = The width of the Glue flap 
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Flap Configuration 

Use the Flap Configuration dropdowns to select the Style and Options for 
the closure flaps. 

And finally press the Finished button to finalize your box. 

Your box is ready to go without any further work but if you should choose 
to do further edits you can open the advanced properties of your box after 
you have pressed the Finished button. 

Flap Closure Style and Options 

<None> - No Flaps 
Used when the box is open on the top or 

bottom with no closure flaps 

 

Standard – Default 
Used as a glue type closure where the 

main wide flap is closed over the top of 
the other flaps 

 

Standard – Overlap 
All flaps are folded over each other 

 

Standard – Reduced Flaps 
This is the type most often used for 

standard shipping cartons that are usually 
glued or taped shut 

 

Standard – Hanging 
This type is commonly used for small 

items that can be hung on peg shelfing  
The top main flap is glued shut.  
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Tuck-in Style 01 and 02 – Default 
Used for boxes that can be opened and 

closed for reuse 

 

Tuck-in Style 01 and 02 – Thumb Cutout 
Used for boxes that can be opened and 

closed for reuse with thumb cutout 

 

Tuck-in Style 01 and 02 – Hanging 
Used for boxes that can be opened and 

closed for reuse with Hanging flap 

 

Tuck-in Style 01 and 02 – Tab Lock 
Used for boxes that can be opened and 

closed for reuse with Tab Lock 

 

Tuck-in Style 01 and 02 – Double Lock 
Used for boxes that can be opened and 
closed for reuse with a Fold Over Lock 

(Top flaps only) 

 

Tab-Closure – Option 01 and 02 
Used commonly for food item cartons 
such a cereal box for re-closure after 

breaking the glue seal (Top flaps only) 
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Tongue Lock – Default 
Interlocking flap system, easily 

disassembled 
(Bottom flaps only)  

 

Crash Lock – Default 
Pre-glued integrated system used for flap 

pack shipping of assembled boxes 
(Bottom flaps only) 

 
 

Add to User Library 

Use the Add to User Library button to save a modified box for future use.  
 

Before clicking on ‘Add to User Library’, 
you can make changes to the Description, 
or not, as required. In this example Box_01 
has been changed to Box_New but the 
Catalog and Style has been left as is. 
 

 
A warning message will remind you that only the 
current state of your box design will be saved in the 
catalog for future use as a template. To proceed to add 
to User Library, click ‘Yes’. 

 
 
If the template already exists, you can choose to ‘Replace 
the existing item in the library’ or ‘Cancel’ and choose a 
new name. 
 
 

Locate your User created Catalog templates by clicking on the Browse Box Library dropdown menu and 
selecting the User Library as shown below left.  
 

Box_New has been created under BOX-WIZARDS / Standard which can now be opened and edited like 
any other template i.e. 
Construction view and 
standard template 
options are available. 
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Chapter 2: Template Library and User Interface 

The following discusses the Box Library and each of the interface elements available when you use the 

lightning bolt  button to create a box/display using a template. 
 

Remember: 

➢ Ctrl+Click to follow internal link to quickly navigate to other parts of this document. 

➢ Return from a hyperlink jump by using Alt+left-arrow [Only with Adobe] 

 

Templates 

Catalog  

The box library includes a Standard 
library of templates organized in 
accordance with the system used by 
the international organizations FEFCO 
(corrugated board) and ECMA (folding 
carton), so that you can find and 
select designs by referring to the most 
commonly used codes on the market.  

As shown, there is a ‘View Catalog’ 
bar which, when clicked, opens a PDF 
with details of all available templates 
and includes images of each template 
in 2D and 3D Views. The Help menu 
also allows you to open the same SAi 
Box and Display Catalog PDF. 

Library 

Browse Box Library: When you start from a template, you will see this dialog. There is a dropdown menu 
to allow you to choose from the ‘Standard’ library supplied or the ‘User’ library of templates that you 
have created and saved to library. 

Standard Library: This is supplied and you click 
on the plus signs to expand the libraries and sub 
directories. Then navigate through the 
templates, clicking on the codes to see a 
preview on the right.  

When you have located the template you desire 
to work with, either double click on selection or 
click ‘Create’.  

User Library: Contains templates that you have 
created and saved to library. After making 
changes to a template or your own FreeForm 
box, you can use the ‘Add to User Library’ 
button as shown below, in the Friendly page.  

See also Chapter 3 - Friendly Page Controls 

 

http://www.fefco.org/technical-documents/fefco-esbo-code
https://www.ecma.org/publications/ecma-code-of-folding-carton-design-styles.html
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User Interface 

The Box&Display User Interface, also known as the Property Inspector, is the next Window that appears. 

Property Inspector 

The property inspector is where the majority of the work takes place and is used to control, configure 
and manipulate the properties of the currently selected template.  

 

The Property Inspector has two main parts. 

1. The Friendly Page Controls on the left.  

2. The Preview Pane on the right.  

 

 

Friendly Page Controls 

Friendly Pages are where related values can be grouped together and referred to with meaningful 
questions. Radio buttons, checkboxes and fields allow the user to define and control the process.  

 

Send to Flexi: Use the Double Sided check box to determine how you want to send your design to Flexi. 

Ticked for both sides and unticked for top only.  

Click on the Send Box button to open your design in Flexi ready for illustrating.  

To return to Box&Display from Flexi, use the  View in SAi Box Display button on the toolbar.  

Show Actual Panel Dimensions: can be turned on - available when Dimensions Edit Option is turned on 
and only in 2D View, as shown in diagram above, and Construction View.  

 

Preview Pane  
The Preview Pane is used for viewing the progress or changes made to the design of the box/display and 
provides controls on the status bar.  

3D Navigation in Preview Pane 
The following allows you to look at your created 3D box/display to your satisfaction. Hotkeys, repeatable 
commands and mouse actions can also be useful for saving time on some of the more common events.  
 

• Rotate the camera: 

Click and drag.  

• Pan the camera:  

Shift + Click and drag  

or Left Click + Right Click and drag  

Active Section 

In Construction View, the box is made up of a series of rectangles known 
as sections. These sections can only be edited one at a time, so it is 
important to know which one is the active one. You can double left click 
or right click and select “At Section” on any section to make it active. 

• Active Section is always highlighted in light blue.  

• Machine step points are a darker blue.  

• Machine steps are denoted by the red lines.   

• Zoom the camera:  

Ctrl + Click and drag  

or Mouse-wheel Up/Down  

or Right click + Drag  

• Reset view: 

Click middle of mouse (wheel).  
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Design Canvas and Status Bar 
The following is a discussion using the diagram below. 

Note: If necessary, drag the window border and vertical divider in order to see the complete status bar. 

1. Design Canvas – Preview Pane 

The preview pane displays your design in 2D, 3D or construction view. 

The status bar displays information about the currently selected section. 

 

 

 

 

 

 

2. Active Section drop down list – each section of the ‘Box/Display’ is automatically provided with a 
descriptive name for easy identification. You can only work on one section at a time and it must 
be made Active before working on it. Use the drop list menu to select required section. 
 

3. Snap Mode 

a.  Snap to Grid                       NB: Right click on this icon to open → 

b.  Snap to Marker 

c.  Snap to Machine Step Point 
 

4. Undo – Redo 

a.  Undo = ctrl-X 

b.  Redo = ctrl-Y 
 

5. Indicators 

a.  Section Failure – See Notes on Error Indicators 

b.  Point Failure 

c.  Unlock/Lock Imports 

d.  Keyboard Focus 
 

6. X, Y Coordinates 
 

7. Coordinates Selector 

a.  Local 

b.  Global 

The following pages discuss the status bar items in more detail. 

8.  Menu drop down 
a. Reset View 
b. Save File 
c. Export to 3D File 
d. Help documentation  
e. Units – change default unit of measure  
f. Back – Return to ‘Browse Box Library’ 
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Item  Choices  Purpose  

Section 
drop list  

 

Displays the name of the current section (editable in the Dimensions 
section of the property inspector). 
 

Drop list of all editable sections.  

Snap to grid  
 Enabled 

Snap to grid markers.   Left click to toggle.  

Right click to change grid spacing.    Green if enabled 

Snap to 
markers  

 Enabled 

Snap to marker machine step points.     
Left click to toggle. 
Green if enabled  

Snap to 
points  

 Enabled 

Snap to any machine step point. 
Left click to toggle. 
Green if enabled 

Undo and 
redo  

 

Left click to step through command history.  
Green if steps are available.  
Shortcut keys: ctrl-Z (Undo) and ctrl-Y (Redo) 

Error 
indicators  

  

Left for section, right for machine step. Hover over the indicator for a 
tooltip describing the error. See Templates and No-Entry  
Left or right click the indicator to correct the problem - a 
message/dialog will appear if a suitable action is available.  
States shown from top: OK, Failed, Wait, No-Entry  

Auto-unlock  
 Enabled 

Automatically remove library section protections as required for 
commands. See Chapter 4 for the consequences of this.  
Left click to toggle. Green if enabled  

Focus 
indicator  

 

Green if preview pane has focus, else a red cross.  
Left click in the preview pane to get focus. 
Shortcut keys and the mouse wheel have no effect if the pane does not 
have focus, and may cause effects in other windows  

Cursor 
location  

 

Current cursor position in coordinate system selected by the adjacent 
global/local toggle.  

Global/Local  
 Global 

Left click to toggle.  
 

Greyed out if local. Green if global,   

View Menu 

 

 

Left click to show complete menu of previews.  
 

Left click in menu to select.  

 

file:///C:/Users/chaz9/AppData/Roaming/Microsoft/Word/Import_section_reference%23_
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Chapter 3: Template - Friendly Page Controls 

The following discusses the Friendly page controls when using Templates .  

For a discussion on Friendly page controls when using Freeform, see Chapter 6. 

Properties  
At the top is mostly information about the template you have 
selected. We can see that we have selected the 0205 template.  
 

 
If applicable, the [Info] button will be active and when 
pressed will open a dialog with extra information, shown left. 
 

Add to User Library 

The User library is a separate to the Standard library, and 
contains only templates that you have created and saved to 
library. To save a modified template or FreeForm box for 
future use the Add to User Library button. You can make 
changes to the Description, or not, as required before ‘Add to 
User Library’ – example below shows result. 

 
Note: This will only save the 
current state of your box design in 
User Library, located by using the 
dropdown. [Default library is 
Standard]. 
 
You can choose to ‘Replace the existing item in the 
library’ OR ‘Cancel’ create a new code/name – 
Example message → 

View Options 
Using the View Options, you can select how your template is displayed. 
[The following template displayed is the ECMA A10_21_03_03] 
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3D View 

Tutorial Video  3D View Controls 

Folding Control   

The Folding Controls are only available when you are in the 3D view. Use the Amount slider or enter a 
number directly into the edit box between 0 and 100 to fold and unfold the current box template.  

 

The Play button allows you to run an animation of the box or display. The stages slider is used to fine-
tune the speed of the folding. [See end of Tutorial 103] 
 

For setting the Folding Sequence see Tutorial 102. 
 

With the Export 3D button, you can save your design to a 3D pdf file. You can export as many times as 
you like e.g. to show customer box at different stages of folding. The customer will be able to rotate, 
pan, zoom in/out the box just as you can in Box&Display. See Chapter 5 – Mouse Actions in 3D. 
 

Important Note: Adobe Acrobat Viewer (free version download) required to view.  
 
 

3D Export 

For 3D Viewing you need to have Adobe Acrobat Viewer 
installed. When you press the 3D Export button discussed on 
the previous page, you will get this message ‘Launch PDF 
Viewer?’ Click ‘Yes’ to continue. 
 

Note that you will need to click once on the pdf view upon 
opening. Click Options and select 
‘Trust’ from dropdown menu. 

 
You will then see your box presented similar to 
screen grab shown left. 
 
Background Color: When you first open the 
pdf, the background will be black, so you may 
like to change the background color using the 
icon indicated by the blue arrow. 
 
Lights from File: It is recommended to select 
the CAD Optimized Lights for a better display 
as shown. 
 
 
  

http://www.printtocut.com/gettingstarted/7_3D%20View%20Controls.mp4
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3D Assemble 

Some boxes may be made in sections as shown below, top right. [Template POS > C8-230 x 300 FSC]. 
When this is applicable, the Remove/Transfer Dividers and Remove/Transfer Tray buttons will be 
presented. Other boxes may only have an Assemble Unit button – See Tutorial 203 Sloped Shelf Display. 
 

Use these to Assemble the box, as shown in the insert. 

 
 

Edit Options 
Use the check boxes to expand the three main edit categories… 

• Materials 

• Dimensions 

• Textures 

Materials  

By ticking the materials check box, the properties for the material that will be used for the selected 
template (0205) are shown.  

 
 

All the properties are user defined and can be edited using the Materials 
editor, accessed by clicking on the Edit button, as shown above. Use the 
dropdown menu to see list of materials. 
 

To create a ‘New’ Material use the New button, as shown. ‘Delete’ a 
material by selecting and then use the Del button. 
 

Tutorial Video  Edit Materials 

http://www.printtocut.com/gettingstarted/2_Edit%20Materials.mp4
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Dimensions 

Tutorial Video  Dimensions  

Show Actual Panel Dimensions, if checked, provides the 
dimensions of individual Panels in the preview panel, in 
2D View, shown, and Construction View. Note that 
dimensions include Fold Allowance which in case is 3mm. 
 

Edit boxes are available to enable you to make changes 
to outside dimensions. Inside dimensions can be figured 
out from the Material Thickness (shown 3mm). For 
example, take off 2 x thickness and add a small clearance 
adjustment, if required. 
 

Lock Proportions check box will set all panel widths, panel heights, flap lengths and flap settings to be 
proportioned by the (A) dimension.  
 

Setup the box to your desired sizes and then click on the checkbox.  

 
 

By changing the (A) dimension all the sizes will change accordingly. 

  
 

Once you have resized, you can uncheck the ‘Lock Proportions’ checkbox, which will allow you 
to make further adjustments by editing B and C sizes directly. 

 

Fold Allowance options are available, if applicable, as shown here for a 0205 template, note difference... 

 

Turned Off – X/Y respectively are 734.8 / 506mm 
Turned On – X/Y respectively are 743.8 / 512mm* (shown) 

     *Y takes into consideration Material Thickness and Fold Allowance. 
 
Slot Width - the first three dimensions in the drop down are controlled by a formula i.e. 
Material thickness multiplied by 2, *3 and *4 and the last three are static. You can, however, 
manually type a dimension into the edit box. 
 

Add Lid and Insert Settings options are available, if applicable, 
as shown here for a FEFCO 0300 template. See Tutorial 208 
Box Inserts to create DXF cutouts to anchor items within box. 
 

The Add Lid option allows you to adjust the Lid Gap as shown…  
 

The first box has 
a gap of 0mm 
and the other 
has a gap of 
10mm. 

http://www.printtocut.com/gettingstarted/3_Edit%20Dimensions.mp4
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Panels 

The mains sides of the box are called Panels.  

Use the dropdown to select the panel you wish to work with. 
Note Panels are numbered from Left to Right. 

The Edit button opens the Edit Panels Properties, shown 
below, for the currently selected Panel.  

 

 

 

 

 

 

 

 

 

Edit Panels Properties 

Recess can be used to change the overlap of flaps or panel in relation each other. For example, -1.5mm 
entered into the top and bottom recess will make flaps connected to the top and bottom of this panel 
fold in below those of panes with a 0mm recess.  

Use the Fold Sequence dropdown to select the order in which you want the panel to fold.  

An Advanced button may be present which will open more options for the panel, similar to the one 
discussed on the next page. 

Use the Select dropdown to select the type of panel to import. 

Another way to recess is to Use Pattern for Panel Recess to 
adjust panel heights, and the ‘Use Material Thickness’ to 
recess by either using the default Material or specifying 
required recess (shown changed from 3mm to 20mm).  

 

The benefit of using this method is that 
you can use one strategy for creasing 
the perimeter foldline. The internal 
fold lines remain separate from the 
perimeter.  
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Panels and Slots 

The image below shows Panel 2 with a Top Recess of 20mm and a Slot Width of 20mm to show that the 
perimeter foldline is continuous, in a zig zag pattern for smooth fold/cut. 

See Template Tutorial 202 - Toolpath and Fold Lines. 

 
 

Standard Flaps 

The options for Flaps work much the same as Panel with 
some differences.  

The Default Length will set the length of all the standard 
flaps unless they have previously edited.  

Pressing the Reset will set all the flaps to the default length including the edited ones.  

If your design requires it, you can use the check boxes to remove all the flaps across the Top or the 
Bottom of the box. 
 

Tutorial Video  Edit Flaps and Panels 

Edit Flaps Properties 

Select and Edit the desired flap on the Edit Flaps 
Properties page. 

 

Most of the flaps have an Advanced button which 
opens the Advanced Edit Properties page for this particular flap.  

 
 
 
 
 
 
 
 
 
 
                 Most of the flaps from the import library will have 
a similar page as this one, with simple diagrams defining 
what the different parameters will change. The numbers on 
the diagram correspond to the edit boxes.  

http://www.printtocut.com/gettingstarted/4_Edit%20Flaps&Panels.mp4
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Tutorial Video  Advanced Flap Settings 

Glue Flaps 

Similar to the panels and standard flaps 
the Glue Flaps can be edited but usually 
have less options.  
 
The default Glue Flap Position is Outside. 
If you want to override then you need to 
turn on ‘Set Glue Flap Position’. As shown 
the glue flap can be folded ‘Inside’ or 
‘Outside’ of box. 
 
 

Textures 

Tutorial Video  Local Textures 

 
The ‘Show Annotation’ checkbox allows all 
annotations to be turned on/off. This checkbox is 
located either under Local Textures as shown right or 
under the Annotation Settings as shown below. 
 
If applicable, you can change the Annotation Settings. The FEFC0 0205 template, shown below right, has 
annotations i.e. A, H and B. Use the Edit button to change these. 
 

 
 

Annotation Settings 

The Edit button opens the Advanced Edit Properties dialog  
which allows you to make changes to position and look of  
annotations and arrows.  
 

The diagram below shown changes to Panel 1 – Annotation 1 
i.e. to A and its line. NB: B is on Panel Annotation 3 not ticked → 

 
 
 
 
 
 
 

 
 

  

http://www.printtocut.com/gettingstarted/5_Advanced%20Flap%20Settings.mp4
http://www.printtocut.com/gettingstarted/6_Local%20Textures.mp4
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Texturing Modes 

Box&Display has three texturing modes  

1. Local Mode  

• Textures are located on your local drives.  

2. Embedded Mode  

• Textures are provided by Flexi.  

3. Local\Embedded  

• Textures are both located on the local drives and provided by Flexi.  

When a new Box&Display project is started, the texturing is set to Local Mode.  

If you click on Textures in the Edit Options, the default 
textures will be displayed in the Local Textures properties 
dialog. 

By default, at this stage these textures cannot be deselected. 
You can, however, click on the three buttons to the right of 
the check boxes to browse your computer for different 
textures, shown below. The Texture Properties (indicated 
with blue arrows on diagram) are the images for each of the 
faces. 

C:\...\Flexi3D\Bitmap\FaceTextures 

If you have made changes to the size or 
construction of the selected item, the texture may 
no longer fit the shape correctly. If this happens 
click on the Update Texture Size button which will 
resize the texture canvas to the extents of the 
shape.  

3D View will show you the result of texture 
changes. 

 

To embed textures from Flexi into your project you must first send your design to Flexi from Box&Display 
to place in the Flexi design environment. See next page – Send to Flexi. 

Once you have selected the View in SAi Box Display  option from the Flexi toolbar, the Local Textures 
check boxes will be activated for the faces that can be changed. You will be able to switch between Local 
and Embedded textures. 

You can use the Show Texture in the Construction View checkbox to do things like tracing around an 
image for a flip-up cutout.  
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Chapter 4: Formula Controlled Sections/Flaps 

Whether you design a box using a template or freeform, everything works the same. The templates, 
however, will almost always have parametric/formula controlled/imported sections/flaps and 
this generally will lead to an initial blocking of freeform, which will be indicated by a red indicator.  

This means that you must look at the error messages behind the red indicator icons on the status line 
whenever it blocks an action. Click on that red status indicator and accept the unlock/message to allow 
things to proceed. See Tutorial 200 and Tutorial 109 – Convert to Standard Construction View 

Context menu options will also be greyed out when you are being blocked like this, as a lot of freeform 
commands simply cannot be done without first removing that formula/import control. 

Error Indicator 

• OK -- no error  

• Failed  - the last command attempted was unsuccessful. The indicator stays red and hoverable 
for about 30 seconds following this event.  

• Wait -- the current command is taking a long time and you must wait. No action is available to fix 
this state, but control should eventually be regained.  

• No-Entry - the active section or machine step is protected from some editing commands, 
which you will see greyed out in the context menu. Left or right clicking the indicator usually allows 
the protection to be removed. However, doing this has consequences.  

Removing the "imported" flag from a library section or subtree means that it will no longer be 
automatically updated if you or the developers change it in the library. Removing the "formula" 
property from a library section removes the Active Section/More box from the property inspector. 
(If it remains visible, then its function is reduced to duplicating the controls already visible in the 
Active Section group)  

“Import section reference. Convert to local copy?”  

Often flaps come from an internal sublibrary and are parametrically controlled with a friendly page 
available to let you change various parameters for the shape and size of the flap. The flap itself gets 
loaded from the sublibrary and will automatically refresh sometimes (e.g. when you reload an old 
drawing). But if you want to modify this imported flap in any way, you need to make a copy of this 
imported flap, so that in future it won’t get refreshed and lose your changes. 

Box&Display knows the types of changes where this 
local copy is needed and insists that you “Convert to 
local copy”, if it is required. In some cases, you will 
see greyed out menu options, showing things you 
cannot do. There are Error Indicators such as the “no 
entry” that appears on the status bar - clicking 
on this will prompt you to “clear the imports”. If you 
are able to select a menu option but Box&Display 

cannot proceed, there will be a big red dot  ‘Failed’ 
indicator and you can click on that as well. 

Tutorial Video  Convert to allow changes to template 

http://www.printtocut.com/gettingstarted/9_Convert-to-Enable-Changes-to-Template.mp4
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“Formula-controlled section. Eliminate formulas?” 

Making a local copy of a section is still not enough if 

the shape is formula controlled. Many flaps have 

parametric controls within them, for example altering 

a parameter might affect more than one dimension in 

the shape. To add/remove points in the shape or drag 

points around when they are part of the boundary of 

a shape, you need to eliminate these formulas. Again, 

Box&Display knows which commands you need to do 

this for and blocks them. If you click on the red dot on 

the status bar in this case, you will get this prompt. 

Once you press OK to eliminate formulas, the parametric control of the shape of this flap will be 

removed, along with internal formulas that were there to control it. You can then freely change the 

shape in almost any way. If you change your mind, don’t forget you can use the Undo button to bring 

back those formulas. Or if it happened too long ago, the easiest thing is to delete the whole flap and 

bring in another fresh one from the flap sub-library. See Tutorial 109 Import Predesigned Flaps. 

You might also wonder what happens if you resize a box which has a flap where the formulas have been 

removed. In this case, the flaps do resize still, but things are scaled proportionately - See Tutorial 109 –

Resize. In some instances’ the result will be quite acceptable, but in others, the flap may have parametric 

properties where a simple scaling is just not good enough. If this is the case, you may need to bring back 

a fresh flap, or edit the shape to adjust it, whichever is easiest. 

 

Lock / Unlock  

Another way to accomplish the same thing is to use the Auto-Lock function. When you Unlock  the 

section, it will unlock imports and formula sections. This means that you will have the ability to do make 

any changes to points, without converting to Construction View, discussed above. 

Left click to toggle between Lock / Unlock . 

 

 

 

 

 

 

  

Consequences 

Removing the "imported" flag from a library section or subtree means that it will no 

longer be automatically updated if you, or the developers, change it in the library.  

Removing the "formula" property from a library section removes the Active 

Section/More box from the property inspector. (If it remains visible, then its function 

is reduced to duplicating the controls already visible in the Active Section group).  
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Stretch Mode and Scaling 

Tutorial 104 discusses Scaling and Stretch Mode. In the examples given there at Step 2, it shows how 

you can change the stretch mode to Proportional, because the default will identify points close to a 

corner, e.g. the chamfer, and make them default to stretch mode “locked to corner”. [See also Tutorial 

105 Parametric Scaling] 

Even a wriggly corner shape will be maintained in its absolute size and shape, or could be scaled as the 

overall size scales, or indeed could be maintained as absolute distances in the x-direction but scaled in 

the y-direction, or vice-versa.  

Removing formulas certainly will lose something if you need to do size changes later on. Looking at some 

of the complex flap shapes, with locking tabs and slots and so on, the full parametric solution provided 

before you remove formulas is of course carefully designed to work fully and will be superior to any 

guesswork approximation you can make by use of any form of pure scaling. 

Removing formulas will also remove the ability to do some other types of configuration changes, e.g. the 

flap might have a setup that allows for two, three or four slots. In the original friendly page control, there 

might be a dropdown that lets you select which option you want. No amount of scaling will change two 

slots to three slots and so on. On the other hand, if you set a flap up at the desired size, and other 

configuration parameters are set to suit your requirements, then removing formulas allows those last 

minute freeform adjustments that just are not catered for in a preconfigured design. You can make little 

one-off changes, cut holes, add little notches, make a change in the border to allow for some extra 

clearance somewhere etc. 
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Chapter 5: Context Menus, Commands and Actions 

Whether you design a box using a template or freeform, everything works the same. The templates, 
however, will almost always have parametric/formula controlled/imported sections/flaps and 
this generally will lead to an initial blocking of freeform, which will be indicated by a red indicator.  

Context menu options will be greyed out when you are being blocked like this, as a lot of freeform 
commands simply cannot be done without first removing that formula/import control.  

Active Section - Main Context Menu 
When you right click on a Section in the Preview Pane, it will make that area active [See What is an Active 
Section? ] and you will be presented with the following context menus… 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

1. Opens the At Section fly out menu  
Shortcut Key: Right Click S 

 

2. Opens Add Machine Step fly out menu  
Shortcut Key: Right Click N 

3. This option will take you to the parent section for the 
current active section 
 

4. Resets View to the centre of the preview pane 
 

5. Click to show hidden sections 
 

6. Click to show hidden machine steps 
 
 

Fly Out Menus 

At Section options 

1. Same as Ctrl + C 
 

2. Releases flap height 
constraints to allow you to 
reset Section Height 
 

3. Set Section invisible 
 

4. Clear Section 
 

5. Clear all Sections attached to Active Section 
 

6. Clear all Sections attached to Active Section and Active Section as well 
 

7. Attach one end of section's base fold (Hinge) to a specified point in its parent section 

When right-clicking elements in your software, a context menu is displayed. The 
context menu will differ according to the element that you are right-clicking on. 
 

Shortcut Keys are available where indicated on the context menu and allows you 
to select the command using the keyboard. 
 

Example: To Add Machine Step > Hole → Hit N on keyboard and then H for Hole 
from the available fly out menu indicated by  
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Add Machine Step options  

1. Sets of points for construction use (local to 
construction preview)  

2. Internal hole (or cutout if it intersects the 
border)  

3. Set of lines which are scored rather than cut in production  

4. Set of lines which are perforated rather than cut in production  

5. Specifies annotation with dimensions  

6. Specifies annotation with labelled arrows  

These machine steps can be formatted. See also Chapter 8 on Machine Steps. 

 

Point, Line or Machine Step – Main Context Menu 
When you right click on a Point, Line or Machine Step in the Preview Pane, you will be presented with 
this menu and access to related Fly Out menu’s… 
 
1. Add a new point before an existing Point 
 

2. Add a new point after an existing Point 
 

3. Clear a Point 
 

4. Move a Point by dragging it to a new location 
Holding down the ‘shift’ key while dragging will constrain to 
last point.  

 

5. Opens the At Point fly out menu  
Shortcut Key: Right Click P  

 

6. Opens the At Line fly out menu  
Shortcut Key: Right Click L 

 

7. Opens the At Machine Step fly out menu  
Shortcut Key: Right Click M 

 

Fly Out Menus 

At Point options 
 

1. Add a new Flap 
 

2. Same as Ctrl – V 
 

3. Paste flap and its sub-tree 
 

4. Import current import flap selection 
 

5. Clip off corner at a 45-degree angle 
 

6. Round off a corner  
 

7. Adjust two arc Corners 
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At Line options 

See At Point  
 
1. Curve a Line with given radius 
 

2. Fillet with Two Arcs 
 

3. Split-machine step into two 
 

4. Tab or Notch (+ or – height setting) 
 

5. Slot controls for inner/outer/centre  
 

6. Circle or Oval Slot 

Note: Most commands on the At Point and At Line fly out menus are repeatable. 
 

At Machine Step options 
 

1. Open or close a machine step 
between the first and last points 

 

2. Select a group of machine step 
points 

 

3. Flip a machine step from one side to 
the other of the section  

 

4. Copy a group of machine step 
points from one side to the other. 

 

5. Fillet all machine step corners  
 

6. Create a Flip-up from perforation 
Machine Step  

 

7. Created Machine Steps such as dimensions and marker, can be formatted  
 

8. Clear a machine step  
 

9. Clear selected machine points 
 

10. Set machine step invisible  
 

See also Modal Cursors 
 

Stretch Mode options 
 

These options are only made available when 
stretching points. See Tutorial 104 Stretch Modes 
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Hotkeys 

• ctrl-C -- copy active section to clipboard (same as At Section/Copy Section to Clipboard) ( )  

• ctrl-V -- paste clipboard section to selected line (same as At Line/Paste Clipboard Section) ( )  

• ctrl-Z and ctrl-Y -- undo and redo ( )  

• ctrl-R -- repeat last command used (see List of Repeatable Commands below) ( )  

• '.' (period / full stop) -- invoke numeric entry dialog ( )  

• <Delete> -- delete active point ( )  

• 1 to 9 -- use Dimension Quick Entry value (hold the digit key down and left click)  

Tutorial Video  Parameters 
 

• Context menu accelerator keys -- the context menu must be open to use these  
For example: L > F are the accelerator keys to At Line > Add Basic Flap. 

• shift – holding down the shift key while moving a straight line, constrains the line to last point 

 if necessary, left click on the pane first to get mouse and keyboard focus.  
 

Repeatable commands: 
The following commands can be repeated using ctrl-R.  NB: Repeats only the last command executed. 
 

• Drag Point  

• Add Basic Flap  

• Paste Clipboard Section  

• Paste Clipboard Subtree  

• Add Import Section Reference  

See Tutorial 107: Repeating Commands  
 

Mouse Actions  

 if necessary, left click on the pane first to get mouse and keyboard focus 

Construction Preview 

• Zoom: Use mouse wheel to zoom ( )  

• Pan: Hold middle button (or Left and Right buttons) and drag. 

• Select Sections: Double left click selects sections  

• Select Points: Left click and drag. A rectangle will display, selecting points for setting stretch modes. 
(Hold ‘Ctrl’ to toggle and ‘Shift’ to extend)  

• Select Lines or Points: Left click selects lines or points as active.  

• Context Menu: Right click on Preview Pane or line/point of Active Section. 

• Chamfer Corner  

• Fillet Corner (rounded)  

• Adjust Two Arc Corner  

• Curve Line  

• Fillet with Two Arcs  

http://www.printtocut.com/freeform/tutorialvideos/04-%20parameters1.mp4
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3D Preview 

• Zoom: Use mouse wheel to zoom ( ) or Right click, hold and move mouse up & down on the screen. 

• Pan: Hold Left and Right buttons and drag to pan in any directions  

• Rotate: Left click and drag to rotate the image (in centre to rotate out of the viewing plane, around 
the edge to rotate in the viewing plane  
 

Construction View Navigation: 

• Zoom: Use mouse wheel to zoom ( )  

• Pan: Hold middle button (or Left and Right buttons) and drag to pan. 

• Select Sections: Double left click selects sections (flaps)  

• Select Lines or Points: Left click selects lines or points  

• Context Menu: Right click on line or point gives a context menu. 

• ctrl-C and ctrl-V are copy and paste ( )  

• ctrl-Z and ctrl-Y are undo and redo ( )  

• ctrl-R is repeat last command ( )   

• '.' (full stop)) is invoke numeric entry dialog ( )  

• <Delete> is delete active point ( )  
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Chapter 6: FreeForm Construction Preview Interface 

The Friendly page is the left hand pane of the BD Property Inspector.  

The Friendly page shown is only available with FreeForm  and the following discussion pertains to the 
numbers in the image. 

 Check the Dimensions checkbox to display the items relevant to 
the Construction preview.  

1. Send to Flexi/Send Box and Double Sided -- sends the current 
box to Flexi for illustration. If Double Sided is checked then the 
design is repeated upside down below the original. 
Illustrations in the ‘upside down’ area are used for the bottom 
face of the box. 

After illustrating click Flexi's View in SAi Box Display  ("eye") 
button to send the results to BD (visible in 3D preview only).  

2. Dimension Quick Entry/Base Line Width -- sets the width of 
the initial Base Line, shown as a dashed line in the preview 
pane, which determines the width of the root section. This 
value may be used to scale the entire box if the required 
stretch options are used (see Tutorial 104 Simple Scale & 
Stretch Modes). Changing this value after the box is illustrated 
requires rescaling the Flexi artwork.  

3. Dimension Quick Entry edit fields and More button -- used for 
entering scaling parameters (see Tutorial 105 Parametric 
Scaling). Parameters may be for immediate use with the 1...9 
numeric shortcut keys, or may be used for parametrising a 
basic design for creating different sized boxes. Note that in the 
latter case changes in scaling may require re-illustrating the 
box.  

Boxes 1-9 can be used for the many repeatable dimensions 
that might be used throughout the building of your freeform box. For example, 
panel widths, flap lengths, chamfers and fillet corners. These dimensions are used in 
conjunction the construction tools. 

The More button in this section opens a dialog box that lets you extend the use of the 1-9 input 
controls. The use of this dialog is discussed in Tutorial 105. 

4. Active Section/Name -- allows renaming the active section. Section names are used in the status bar 
drop list. If you use illegal characters, or accidentally rename a section to have the same name as 
another section, then the name is automatically modified to prevent any conflict.  

5. Active Section/Height -- allows changing the height of the active section. There is also a context menu 
command for this purpose: At Section / Adjust Section Height  

6. Active Section/Fold Angle -- by default sections fold to 90 degrees when Fold% is 100%. This can be 
adjusted here, and Clockwise can be unchecked to reverse the fold direction.  

7. Active Section/Scale Ht w Wth -- "scale height with width". If checked the aspect ratio of the section 
remains constant if its width is changed. Otherwise the height remains constant if the width is 
changed. (see Tutorial 104 Simple Scale & Stretch Modes). 
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8. Active Section/Fold Sequence -- sets the section's position in the folding animation (left=early 
right=late). The number of valid stages is set by the Folding Control/stages slider, which is only visible 
when the 3D preview is displayed.  

9. Active Section/Edit Offsets – button which opens dialog box which allows the addition of an offset 
to the flap. See notes below for more details. 

10. Active Section/Edit Import button is only made available when an imported section is made active. 
(see 12 - Clipboard & Imports) 

Notes on Active Section 

The image on the right shows 2 rectangles one on top of the other. The 
bottom rectangle is a flap that was added to the Base Line discussed earlier 
and the top rectangle was added to that flap.  

These rectangles are also known as sections. These sections can only be 
edited one at a time, so it is important to know which one is the active one. 
The active section is always highlighted in light blue and the machine step 
points are a darker blue. The machine steps are denoted by the red lines. 
You can double left click or right click and select “At Section” on any section 
to make it active.  

Properties for the Active Section shown →  

Name field displays the section name which 
can be changed to something more 
meaningful if required.  

Height field. NB: The height of all sections, other than the starting section, is measured from the 
green dotted base line protruding outward regardless of the position or direction the flap\panel is 
protruding.  

Fold Angle will set the angle in degrees the flap\panel will fold in relation to its parent section. When 
the value for this control is set to 0deg the flap will not fold at all and will be in line with the parent 
section. 

With the Clockwise checkbox, you can set the direction the flap\panel will fold. If checked the 
flap\panel will fold clockwise and unchecked for counter clockwise.  

Scale Ht w Wth, if checked, will turn on the automatic scaling for the active section and cause its 
height to change in proportion to a change its width.  

Fold Sequence slider control allows for 8 possible increments in a sequence. By moving the slider 
from left to right, you can set the step for current 
flap\panel to fold in the sequence.  

Edit Offsets button is used for adding an offset to 
the flap. The offset is often used to subtract the 
thickness of the material you are using for the flaps 
to close. Click on the button to open the dialog, as 
shown right. From the Configuration dropdown, 
select how the offset will be applied e.g. Left, 
Right, Both etc. The applicable edit boxes will be 
made available to allow you to set the amount of 
the offset or use the checkbox to set the value to 
use the material thickness, in this example is 
0.5mm, applied to Left.  
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11. Active Point lists properties of the current active point, if there is one. Points in the active section 
may be selected, as the active point, by left or right clicking the point, or by left or right clicking the 
line joining them to the next point in their machine step.  

The active point is indicated by a "bullseye" , and the other end of the joining line 
is decorated with an arrowhead. The two editable fields display the local 
coordinates of the point within its section, and can be used to move it elsewhere. There is also a 
context menu command for this purpose: Drag Point G (which offers the additional ability to move 
the point using global coordinates).  

 

Notes on Active Point 

Right click on the Active Point  to bring up its context menu with a list of options 
and operations that can be performed on it.  

The Machine Step field displays the name of 
the current shape you are working with, 
which in this example is “Flap”.  

The Index field shows the number of the active point e.g. “2”. Points are numbered in a clockwise 
direction starting with the one attached to the left end of the hinge line and ending at the right end.  

The next 2 boxes show the exact (x, y) position of the point in relation to the container section and 
their lock status.  

If you left click and drag a box around the active 
point, or a group of points, the locking status will 
be shown by arrows. 

 

12. Clipboard & Imports 

Although you can make your complete design 
from scratch, you can also incorporate some 
of the predesigned flaps or even copy a flap 
that you have designed into your project.  

The Clipboard & Imports properties lets you select a flap from our predesigned library to make it 
available to be imported into the active section using the right click context menu*. You can use the 
standard keyboard shortcut commands ctrl-C and ctrl-V to copy and paste flaps. When an imported 
section is made active an Edit Import button is only made available [See 10 – Active Section/Edit 
Import].  

The Section Copied field displays the name of the section currently in the clipboard.  

*See Tutorial 107 Repeating Commands - "Paste Clipboard Section" (or Ctrl-V) and "Paste Clipboard 
Subtree". 
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The following items are only visible if Dimensions is checked AND the 3D preview is selected:  

o Folding control/Fold % (slider and edit box) -- these change 
the location of the displayed box in the folding animation 
sequence from 0%=unfolded to 100%=fully-folded  

o Folding control/Play -- toggles the animation between playing 
and stopped states  

o Folding control/Export 3D -- opens a file save dialog for saving 
the 3D preview in various exchange formats  

The following items are only visible if Textures is checked:  

o Local Textures/Show Texture in Construction View -- check 
this if you need to align items with existing artwork  

o Local Textures/Top Face -- never clickable in a Flexi-illustrated 
box  

o Local Textures/Bot Face -- clickable if the Flexi illustration is 
one-sided - gives a dialog to choose the bottom texture  

o Local Textures/Edges -- gives a dialog to choose the edge 
texture  
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Chapter 7: FreeForm - Create New Box/Display 

On the Flexi toolbar, it is recommended that you click on the lightning bolt  button, which allows 
you to use existing templates which you quickly and easily modify to meet your requirements. [See 
Chapter 1 – Create New Box/Display using Template] 

The option to create your own templates by using the plus sign  button but note that the design of 
a functional package or POS is quite intensive. 

Using the New  button, plus sign, directly opens the BD (Box&Display) user interface called the 
Property Inspector, with the Friendly page and Preview panes as shown below.  

[See Chapter 6 – Construction Preview User Interface] 

 

If the Construction preview option is chosen (as it is initially, shown above, the radio button on the 
Property Inspector, under View Options) then the window looks like this, with the box name FreeForm, 
(other previews are blank at this stage). At the bottom of the preview pane there is the Construction 
View Status bar.  

If you decided to create your own template, you need to understand that boxes in Box&Display are 
constructed from… 

• Sections, a tree-structured pattern, which are the conceptual parts which fold relative to each 
other (in 3D view).  

• Root section anchors the whole structure. 

• Branch sections connected to the root section and folding relative to it.  

• Sub-branches connect to the branches, and  

• Leaves connect to the sub-branches.  

When you use templates, this structure is already constructed for you, but in Freeform you must 
construct it yourself.  

Apart from the arbitrary choice of the root section, the requirement that the box is cut from a flat sheet 
of cardboard essentially determines the tree structure, so the construction process requires no design 
choices.  

New sections generally attach to straight-line segments of the border of an existing section, overlaying 
the border segment with a fold line which is represented by a dashed line, and in production will be 
scored rather than cut. In order to start the whole process, you need an initial base line, which is the sole 
purpose of the dashed line which appears when you start a new Freeform box (as shown above).
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Tutorial Video  Make A Cardboard Cube.  

Step 1 

Base Line Width 
In Construction View, if you tick the Dimensions options, you will see that the default width of the Base 
Line is 300mm. Change this to 200mm. 

 

Add New Section 

To add a new section… 

• Right click on the ‘Base Line’ and choose At Line > Add Basic Flap [L > F] from the context menu.  

[See Chapter 5 Context Menu Options] 

 

If you now left click, you will create an arbitrary or 
estimated dimension line when you drag the 
rectangle perpendicular to the base line. Note the 
Height [252.6] is stated in the status bar. Left click 
to complete process. NB: To abort the process, 
either <Escape> or right click.  

• To provide an actual dimension, click the ‘period’ key on your keyboard which will provide a Section 
Height dialog to allow you to enter a precise measurement. 

http://www.printtocut.com/freeform/tutorialvideos/01-%20cube1.mp4
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By repeating this action 5 times you can easily recreate the following picture:  

 

• To achieve creating sections quicker, put a number in the Quick Slots [shown below (1) 200mm]. 
Then L > F and hit “1” and hold down while you left click to complete. 

 

• Another way to achieve adding repeated sections is to left click on the base line and use ctrl-R. [See 
list of repeatable commands and Tutorial 107]. This will continue to add sections with the same 
dimensions until you achieve the result as shown in point 2 above. 

If you make a mistake use ctrl-Z Undo and ctrl-Y Redo 

3D Preview 

Selecting the 3D preview and then dragging the Fold % slider 
gives a rectangular sided box. 

Step 2 

Add a Lid 

If we want to add a lid to the box, we need to add a new section to one of the lines near the edge of the 
drawing. 

It is not possible, however, to select 
these lines by right clicking. (Construction 
view has an active or selected section, 
and it is only possible to select items 
which belong to that section). 

To change the active section double click 
inside the desired section. The filled area 
of the active section is highlighted in 
blue-green, and its points and lines 
change colour.  



Chapter 7                                                                                                                             Create New - FreeForm 

  
Page 47 

Now add a new section to the top line of the picture, i.e. left click and 
Ctrl + R. Note that you may need to pan down to see your addition in 
the preview pane properly. [To pan using the mouse - 
simultaneously hold down the left and right mouse buttons and 
move the mouse in the direction you want to pan]. 

The inset shows the resulting box in 3D.  

 

 

 

 

2D shows machining and 3D can be folded by using 
the Fold Slider. 

 

Step 3 

Illustrate Box with Flexi 

Now we will illustrate the box. To do this we need to give Flexi the cutting instructions, which is a DXF in 
2D line view with cutting and creasing instructions. 

Follow numbers on the diagram… 

1. Send to Flexi by clicking the Send Box.  

Close the BD Property Inspector, using the 
top right X.  

To open/view the BD use the eye icon on 
the toolbar. 

2. Select a rectangle from the Main Toolbar. 

3. Click and drag to select the design. 

4. Select a swatch, in this example we select 
Rainbow. 
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You will notice that the swatch now covers the design, so you will need to Send to Back. 

a. Click Design Editor on the 
Standard Toolbar. 

b. Select the Objects tab on the 
presented dialog 

c. Right click on Layer for menu. 

d. Select Order > To Back. 

 

 

 

 

Now we will add rectangles and stars and allocate swatches.  
 

• To set the default colour hold down ctrl-Y and then select a 
swatch.  
 
Of course, you can also copy and paste the shapes. 

 
The result. 

 

 

 

See Tutorial 101 discussed at the end of this 
manual for more commands and their uses. 

 

 

 

 

Step 4 

Save File 

In Tutorial 103 we will use this design to learn more about adding flaps, so save your file for future use. 

Use the File > Save or Save As… 01+ cube (note that the file extension will be fs) 
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Chapter 8 Freeform Capabilities 

Sections 

Boxes in BD are constructed from a tree-structured pattern of sections, which are the conceptual parts 
which fold (in the 3D view) relative to each other.  

There is a root section which anchors the whole structure, with branch sections connected to it and 
folding relative to it. Then sub-branches connect to the branches, and leaves to the sub-branches.  

When you use templates, this structure is already constructed for you, but in Freeform you must 
construct it yourself.  

The Freeform construction interface can perform the following operations on Sections: - 

Command  Purpose  

Copy Section to Clipboard  copies a section or section subtree  

Paste Clipboard Section  pastes a copied section at a given line  

Paste Clipboard Subtree  pastes a copied section subtree at a given line  

Add Import Section Reference  attaches an instance of a standard library section or subtree  

Delete Section  deletes a section which has no subsections  

Delete All Subsections  deletes section subtrees from a given section  

Delete Section & Subsections  deletes given section and its subtrees  

Hide Section  temporarily hide a section (construction preview only)  

Adjust Section Height  changes the height of a section (as measured perpendicular to its base 
fold)  

Add Machine Step  see below for the kinds of machine steps which are available  

Attach Hinge to Point  attach one end of section's base fold to a specified point in its parent 
section  
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Machine Steps 

The Freeform construction interface can perform the following operations on Machine Steps (polygons 
which specify machining operations and the filled areas in Construction and 3D previews).  

The available machine steps are:  

• Border - sections are created with a border machine step, which is cut out in production  

• Markers - sets of points for construction use (local to construction preview)  

• Hole - internal hole (or cutout if it intersects the border)  

• Fold - set of lines which are scored rather than cut in production  

• Perforation - set of lines which are perforated rather than cut in production  

• Dimension - specifies annotation with dimensions  

• Label Arrow - specifies annotation with labelled arrows  

 

Command  Purpose  Tutorial 

Delete Machine Step  permanently delete machine step   

Hide Machine Step  temporarily hide a machine step (construction 
preview only)  

 

Open/Close Machine Step  toggle the open/closed property of the machine step 
polygon  

 

Select Machine Step Points  select all points in a machine step (for setting stretch 
modes)  

 

Mirror-complete Machine Step  append mirror-reversed copy of existing points (with 
respect to base fold midline)  

106 

Mirror-reverse Machine Step  mirror points with respect to base fold midline  
 

Convert to Flip-up  convert a perforation machine step to a flip-up  111 

Round off Machine Step Corners  fillet all machine step corners  108 

Format Machine Step  edit properties of annotation machine step  110 

 

Tutorials – the following are located at the later in this manual. 

106 Making Custom Flaps  

108 Curves and Fillets  

110 Annotation / Dimension  

111 Making a Flip-Up  
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Machine Step Points 

The Freeform construction interface can perform the following operations on individual Machine Step 
Points:  

 

Command  Purpose  

Add Points Before  add one or more points before the active point  

Add Points After  add one or more points after the active point  

Delete Point  delete the active point (or the whole Machine Step if it only has one 
point)  

Drag Point  drag the active point to a new position  

Chamfer corner  replace a corner point with a diagonal line  

Fillet corner  replace a corner point with a circular arc  

Adjust Two Arc Corner  fix the smooth tangent fit of a two arc corner after the adjacent lines 
were changed  

There are also several commands which are generalisations of Machine Step Line commands to the 
conceptual lines joining any 2 points in the active section.  

1. The active point is used as the first of the 2 points. 

2. The command operation starts with a rubber band which allows you to select the second point.  

3. After you select the second point with a left click the procedure continues in the same way as 
the related At Line command.  

Command  Purpose  

Add Basic Flap  attach a new rectangular section to the line  

Add Clipboard Section  attach a copy of the clipboard section to the line  

Add Clipboard Subtree  attach a copy of the clipboard section and its subtrees to the line  

Add Import Section Reference  attach an imported instance of the section or subtree selected in 
Clipboard_&_Imports/Section  
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Machine Step Lines 

The Freeform construction interface can perform the following operations on individual Machine Step 
Lines:  

Command  Purpose  Tutorial  

Add Basic Flap  attach a simple rectangular section to the line  
 

Add Clipboard Section  attach a copy of the clipboard section to the line  
 

Add Clipboard Subtree  attach a copy of clipboard section and its subtrees to the line  
 

Add Import Section 
Reference  

attach imported section as per Clipboard_&_Imports/Section in 
BD Property Inspector  

 

Curve Line  convert a line into a circular arc, or adjust the curvature of an 
existing arc  

* 

Fillet with Two Arcs  convert the line into 2 arcs with smooth connections  * 

Split Machine Step  
 

Add Tab or Notch 
 

Add Slot 
 

Add Circle or Oval Slot 

break the machine step at a new point located on active line  
 

attach a rectangular tab or notch to the line 
 

insert a rectangular slot inside active section 
 

insert a circular slot inside active section 

** 
 

** 
 

** 
 

** 

 

* Tutorial Video  Curves and Fillets  

** See Tutorial 113 – Add Tab, Notch, Slot (after splitting a machine step) 
 

Modal Cursors 

Commands may be divided into "immediate" and "modal". 

• Immediate commands are completed when you click in the context menu.  

• Modal commands put the mouse into a special state and require a user input to complete (generally 
moving the mouse to a location and left clicking). Modal commands may be aborted using Escape or 
right click. In some modal states the mouse uses the normal arrow cursor. In these cases, the modal 
state is evident from the presence of a rubber band line or a drag rectangle.  

 

Name  Picture  Meaning  

Standard Arrow  
 

No selectable point nearby  

Cross  
 

Selectable point nearby  

Diagonal Cross  
 

Choosing an exact spatial location (accuracy needed unless snap is 
active)  

 

http://www.printtocut.com/freeform/tutorialvideos/07-%20curves1.mp4
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Modal Command Procedures 
• Add Basic Flap,  

• Copy Section to Clipboard,  

• Paste Clipboard Section,  

• Paste Clipboard Subtree, 

• Add Import Section Reference 

If using the At Point variant, the active point becomes the start point of a rubber band line. Move the 
cursor near another point in the active section. Left click when the cursor changes to a cross.  

Both At Point and At Line variants:  

• Move the mouse perpendicular to the baseline to 
drag the rectangle which tracks the new section's 
height. The current numeric value is displayed at 
the bottom right of the pane. Use the 1 to 9 digit 
hotkeys to lock the height to a Dimension Quick 
Entry value (you can still move the mouse to select 
which side of the baseline the section is attached to). Left click to use the current height.  

• While dragging the rectangle, you can press ‘period / full stop’  key 
to open a numeric entry dialog for setting the section height exactly.  

• Some import sections have border machine steps which depend on the 
section height in unexpected ways or not at all. In these cases, the 
image of the new section may follow the drag rectangle in an unusual 
fashion.  

Adjust Section Height 

Move the mouse perpendicular to the baseline to drag the rectangle which tracks the section's new 
height. The current numeric value is displayed at the bottom right of the pane. Left click to use the 
current height.  

The 1 to 9 and ‘full stop’ hotkeys may be used in the same way as for Add Basic Flap.  
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Add Machine Step 

It is irrelevant where you right click to open the context menu when adding a machine step.  

After choosing the machine step type from the submenu, the cursor changes to a diagonal cross  for 
choosing the location of the first point.  

• Left click to choose a point, or press ‘period / full stop’  key to enter the coordinates 
numerically (in either global or section-local coordinates).  

• Cancelling out of the numeric dialog ends the command, otherwise the cursor remains a diagonal 
cross and you can choose another point.  

• For points, other than the first, the cursor is connected to the previous point by a rubber band 
line.  

To terminate the command, use Escape or right click. Points which you have already left clicked are not 
erased by terminating.  

If you move the cursor over the first point of the machine step it changes to an ordinary cross and left 
clicking will close the machine step and terminate the command.  

Zooming in sufficiently should allow you to add a point near the endpoint without snapping.  

The Dimension machine step differs from usual in that the first machine step point is not visible. 
However, it still serves as the start of a rubber band line, so its position is nevertheless apparent.  
 

Drag Point 

The selected point tracks the cursor, and can be fixed in a new location by left clicking.  

While dragging the point, you can press ‘full stop’  to open a numeric entry dialog for setting the 
location exactly.  

Dragged points are subject to the current snapping modes. If you move the cursor near a snapping target, 
then the dragged point will jump there (note the cursor itself does not snap).  

 

Add Points Before, Add Points After 

A new point is added before or after the selected point and then tracks the cursor, and can be fixed in a 
new location by right clicking. After right clicking an additional new point is created, and can likewise be 
dragged.  

Terminate the command with escape key. A newly added but unpositioned point will be deleted.  

The dragged point is subject to the current snapping modes. If you move the cursor near a snapping 
target, then the dragged point will jump there (note the cursor itself does not snap).  

While dragging the point, you can press ‘period / full stop’  key to open a numeric entry dialog for 
setting the location exactly. Cancelling out of the numeric dialog terminates the command, otherwise a 
further new point is created and can be dragged.  
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Attach Hinge to Point 

This advanced command is chiefly used for repairing sections which have been detached from their 
anchor points in their parent section (for example, if one or both of the anchor points is deleted). Such 
repair is unnecessary unless the child section is scaling incorrectly.  

Select the child section. Right click close to one or other end of the child section baseline, as this 
determines which anchor point is affected.  

The active section changes to the parent section. Move the cursor near a machine step point in that 
section, and it should change to a cross.  

Left click to select the point. The child section baseline and the entire child section will change to reflect 
the new anchor point.  

Curve Line 

Move the cursor perpendicular to the baseline to drag a rectangle which contains the arc. Left click to 
select the current curvature. See Tutorial 106 

If you drag the rectangle far enough the arc will stop responding, since arcs exceeding a semicircle are 
not supported. However, this is an easy way to get an exact semicircle.  

While dragging the rectangle, you can press ‘full stop’ to open a numeric entry dialog for setting the 
curvature exactly. The value 1.0 represents a semicircle, and 0.0 is a straight line. In addition, there are 
buttons which set the curvature so that one or other of the adjacent lines is a tangent to the curve 

Tutorial Video  Curves and Fillets  

Note that in order to select a Machine Step Line drawn as an arc you must click near the chord (the line 
connecting the 2 endpoints) rather than on the visible arc.  

Chamfer corner, Fillet corner 

The corner point converts to 2 points joined by a diagonal line or circular arc. Move the cursor 
perpendicular to the diagonal line or arc to choose the amount of chamfer or fillet. Left click to select 
the current value.  

During this process, you can press ‘full stop’  to open a dialog for selecting the chamfer or fillet amount 
numerically. The numeric value is the distance from the original corner to each of the new points.  

Also, you can hold one of the 1 to 9 digit hotkeys to snap the chamfer or fillet amount to a Dimension 
Quick Entry value.  

Since chamfering and filleting destroy the original corner point the chamfer or fillet amount cannot be 
adjusted after the command is terminated (except by undoing the command).  

Split Machine Step 

This command breaks a machine step at a point on the active line. Two new points are added, creating 
a small gap, which is constrained to move along the active line as you move the mouse. Left click to 
complete the current command.  

Numeric entry is available by pressing ‘full stop’  key which opens a Precision Input dialog.  

If the machine step was originally closed, then it is now open and these 2 points are its endpoints. If the 
machine step was open, then splitting creates 2 machine steps, and the 2 new points are each an 
endpoint of one of the new machine steps.  

http://www.printtocut.com/freeform/tutorialvideos/07-%20curves1.mp4
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Add Tab or Notch 

This command creates a tab or a notch which can be repositioned by moving the cursor up or down the 
active line or accurate measurements can be entered via a dialog. Subsequent tabs/notches will be 
reproduced with the same height and width until changed or the current BD session is terminated. 

A tab is created when the height measurement is a positive number. A notch is created simply by 
changing the height measurement to a negative number.  

Numeric entry is available by pressing ‘full stop’  key which opens a Precision Input dialog.  

Add Slot 

This command creates a rectangular slot which can be repositioned by moving the cursor up or down 
the active line or accurate measurements can be entered via a dialog.  

Edit boxes that control the inner/outer/center line offsets are provided in addition to the height 
measurement. Like the ‘Tab/Notch’ width, height and offsets are remembered i.e. every subsequent slot 
created will be reproduced in this manner until either measurement is changed or the current BD session 
is terminated. 

Note: These offsets all interact. It creates the extra Hole machinestep and puts it in the “-Cut” layer (or 
uses whatever you specify as _mscutlayer). 
 

Numeric entry is available by pressing ‘full stop’  key which opens a Precision Input dialog 

Add Circle or Oval Slot 

This command creates a circular or oval slot in exactly the same manner as creating rectangular slots 
discussed above. Slots can be repositioned by moving the cursor up or down the active line or accurate 
measurements can be entered via a dialog.  

Numeric entry is available by pressing ‘full stop’  key which opens a Precision Input dialog 
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Tutorial Videos 

The following is a list of the available videos, which have been referenced throughout this manual and 
can be accessed at http://www.printtocut.com/ 

Box and Display Getting Started Videos  

To help you to quickly create your own design from scratch, the following videos discuss … 

➢ the interface/friendly page options 

➢ context menus used in Construction View  

➢ creating and folding a box  

 
 Getting Started Videos 

 
1. Starting a New Project 

2. Edit Materials 

3. Edit Dimensions 

4. Edit Flaps & Panels 

5. Advance Flap Settings 

6. Local Textures 

7. 3D View Controls 

8. Send Box to Flexi 

9. Convert to allow changes to template 

 

 Advanced Freeform Video 
Watch how to create Pen Holder Display with slots, holes, notches and tabs in a 7 part video tutorial. 
See also Tutorial 113 in this manual. 
 

You may also like to watch 
 How to Create a Corrugated POP Display in Seconds Using BD  

OR copy address to your browser: https://www.youtube.com/watch?v=GbRLKmuuSH4 

 

 Freeform Interface & Basics Videos 
 

1. Quick Entry Dims 

2. Active Section 

3. Active Point 

4. Clipboard & Imports 

5. Add Flap & Points 

6. Delete-Drag-Undo-Redo of Point 

7. Chamfer Fillet & Adj 2 Corners at Point 

8. Tutorial 101 – Create New Box 

9. Tutorial 102 – Fold Sequence 

 

http://www.printtocut.com/
http://www.printtocut.com/gettingstarted/default.htm
http://www.printtocut.com/gettingstarted/default.htm
http://www.printtocut.com/freeform/fftutorials.htm
http://www.printtocut.com/freeform/fftutorials.htm
https://www.youtube.com/watch?v=GbRLKmuuSH4
https://www.youtube.com/watch?v=GbRLKmuuSH4
http://www.printtocut.com/freeform/basics/ffbasics.htm
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 More Freeform Videos link 

The following are list of FreeForm tutorial videos that begin with the creation of a simple cube and then 
build on this to discuss more complex capabilities. 

Step by step instructions can be found in the related Chapters/Tutorials of this User Guide. 

1. Make A Cardboard Cube – See Chapter 7 

2. Add Flaps and Glue Tabs – See Tutorial 103 

3. Simple Scale Propagation – See Tutorial 104 

4. Parametric Scaling – See Tutorial 105 

5. Making Custom Flaps – See Tutorial 106 

6. Repeating Commands using ctrl-R – See Tutorial 107 

7. Curves and Fillets – See Tutorial 108 

8. Importing pre-designed flaps – See Tutorial 109 

9. Annotation using Dimension and Arrow – See Tutorial 110 

10. Making a Flip-Up – See Tutorial 111 

11. Rivet Holes – See Tutorial 112 

 

 Templates – How To Videos  

Since the design of a functional package or POS is quite intensive, it is recommend using and modifying 
existing templates. Use the link above to see how easily templates can be modified. 

Relating step by step instructions can be found in the User Guide (links below).  

➢ X017 Clinton FSU (Point of Sale display) – See Tutorial 201 

➢ Sloped Shelf Display [F SSD] Features (Point of Sale display) – See Tutorial 203 

➢ DXF CutOuts1 [Swan] and CutOuts2 [convert to Rocking Horse] – See Tutorial 204 

➢ CounterTop and Flip Up – CL-FL-300 [folding demo] (Point of Sale display) – See Tutorial 205  

➢ Super Hero Flip Up – CL-FL-300-2 (Point of Sale / Countertop display) – See Tutorial 205 

➢ Modern Shelf (Furnishing) – See Tutorial 206 

➢ X063 Dillon Table (Furnishing) – See Tutorial 207 

➢ X101 Giraffar FSU (Point of Sale display) – See Tutorial 207 

➢ X106 Loxo Standee (Signage display) – See Tutorial 207 

➢ X132 Cocktail Table - Plus (Furnishing) – See Tutorial 207 

➢ The Cube (Utility Item) 

➢ Box Inserts - – See Tutorial 208 

Box Wizard can be used to create your own templates and is the perfect tool for quickly designing one 
off and small runs of boxes and shipping cartons. It is fast and easy to use with a very intuitive interface. 

http://www.printtocut.com/freeform/fftutorials.htm
http://www.printtocut.com/help/SAi%20Box%20and%20Display%20User%20Guide.pdf
https://printtocut.com/templates/default.htm
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FreeForm Tutorial 101 – Create New Box 

In this tutorial, you will learn how to create a small carton or box from scratch. 

Tutorial Video  SAi Box and Display Tutorial 101 

Step 1 

Start by Creating a Box&Display project 

• From the Flexi tool bar, select New  

• It takes a moment for the project to load. 

Step 2 

Starting your design 

• Click on the Dimensions check box 

• Set Dimensions 

Change the Base Line Width from 300mm (default) 
to 200mm 

 

 

Step 3 

Create Main Panel – Basic Flap 

Note: Flap and Panel are synonymous terms in the construction view 

• Right click on the Base Line to bring up the context menu, as shown. 

• Press the L key for Line to open the fly out menu 

• Press the F key for Flap 

• Press the “full stop” key to open the Section Height dialog  

• and type in 300 

 

This will result in the following  

 

 

 

 

 

 

 

http://www.printtocut.com/help/SAi%20Box%20and%20Display_Tutorial_101.mp4
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Step 4 

Dimension Quick Entry 

In the Dimension Quick Entry boxes enter in 
following dimensions for use in building our 
box (1) 125mm, (2) 200mm, (3) 50mm 

 

Step 5 

Add a Second Panel 

1. Right click on the right hand side line to bring up the context menu 

2. Press the L key for Line to open the fly out menu  

3. Press the F key for Flap  

4. Hold down the “1” key and move your mouse up from the selected line 
and Left click.  

 

Step 6 

Adding More Panels 
• Double left click on the newly created panel to select it. (Note the color change to light blue). 

• Using the methods learned in Step 5, create two more panels to the right of the previous ones.  

 

• Use dimension (2) for the next panel and dimension (1) for the final panel. 

• These 4 panels form the sides of your box. 

Note: If you make a mistake and need to Delete 
a Section, select section (highlighted blue) and 
from the context menu, press S and then D. 

OR use ctrl-Z Undo and ctrl-Y Redo 

 

Step 7 

Adding Lid Flap to Main Panel 

• Double left click on the Main Panel 

• Right click on the line at the Top edge of the main section to 
bring up the context menu 

• Press the L key for Line to open the fly out menu 

• Press the F key for Flap  

• Hold down the “1” key and move your mouse above the 
selected line and Left Click. 
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Before proceeding with Step 8, we need to reduce the Height of the Lid Flap from 125mm to 124mm. 

 
 

Step 8 

Adding Tuck Flap to Lid Flap 

• Double left click on the Lid Flap added in Step 7 

• Right click on the line at the Top edge of the flap you just added  

• Press the L key for Line to open the fly out menu 

• Press the F key for Flap  

• Hold down the “3” key and move your mouse above the selected line and Left Click.  
 

Step 9 

Fillet Flap Corners 

• Right click on the point in the top left corner of the 
flap you just created. 

• Press the P key for Point to open the fly out menu. 

• Press the R key for Round  
 

• Hold down left mouse button and drag to set the size of the fillet and let go of the mouse button. 

 
• Left click on the right top point 
• Press ctrl - R to repeat the command. This will create the exact same radius on the right as 

previously created on the left. 
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To ensure that the box will close well, we need to add an 0.8mm gap on either side to. 

• Click on the Edit Offsets button to open Override Offsets Properties dialog 

• Select (4) Left/Right from the Configuration dropdown 

• Enter in 0.8mm in both edit boxes as shown and click ‘OK’ to save and close. 

 

Step 10 

Create Dust flap 

• Double left click on the panel left of the Main Panel 
• Use shortcut keys L > F to add a flap. 
• Drag flap to size, manually, above the panel 
• Look at the task bar coordinates in the bottom right 

corner of the preview pane to set the length of the flap 
to about 75mm. It does not have to be exact, as shown 
here it is 75.7.  
 
 

Step 11 

Adding a Glue Flap and Chamfer Corner 

• Select the Main Panel and right click on the 
line at the left edge  

• Using one of the methods learned earlier 
add a flap and set its width to be 50mm 

• Use the at Point P option to chamfer C the 
outside corners to 35mm 

 
 
 
As in Step 9, to create Fillet, click and drag on top point, as shown. 
If you hit the “full stop” key, you will be presented with 
a dialog box where you can enter the Corner Dimension 
of 35mm. Note: Measurement is not the length of the 
chamfer but the distance across as shown. 
 

Then point on the bottom point, left click and ctrl-R to repeat the 
chamfer. You will be presented with the Corner Dimension dialog 
and you can click ‘OK’ to 35mm. 

Tutorial Video  Chamfer Fillet&Adj 2Corners at Point  

http://www.printtocut.com/freeform/basics/FreeForm_7_Chamfer%20Fillet&Adj%202Corners%20at%20Point.mp4
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Step 12 

Copy/Paste Flaps 

1. Double left click on the Lid Flap (1) 
section at the top of the main panel. 

Press ctrl -C to copy this flap  

Double click on the section that you 
want to add the flap to, to make Active 
i.e. will turn light blue. 

Left click on the line you want to paste 
the flap to and press ctrl -V to paste the 
flaps (1) 

2. Repeat for Tuck Flap (2) paste as shown 
(2) 

3. Repeat for Dust Flap (3) paste as shown (3) three times, as shown. 

 
The following shows the completed box in 2D view. 
 
 
 
 
 
 

Step 13 

Send to Flexi and Save File 

The next tutorial will use this design, so save your file for 
future use. 
 
To do this first “Send to Flexi” by using the Send Box 
button. You can now close the BD Property Inspector. 
 
 
 

Then use the File > Save or Save As… Tutorial 101  
Note that the file extension will be fs 
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FreeForm Tutorial 102 – Fold Sequence 

In this tutorial, you will learn how setup the fold sequence, take our design in and out of Flexi Sign Pro 
and then fold our finished box in Box&Display.  

Tutorial Video  SAi Box and Display Tutorial 102 

Step 1 

View in SAi Box Display 

• Open tutorial 101 that we saved in the previous tutorial 

• Use the “eye”  button to View in SAi Box Display 

Here is the box we created in Tutorial 101. The 
sections have been numbered as we are going to 

learn how to get the box to fold in sequence. 

Sequence 

If we use the Folding Control, without setting a 
sequence, then the box will fold simultaneously (as 
shown). Since we want to watch the sections fold, 
we need to set the sequence for the fold. 

 

 

 

Step 2 

Setting the Stages Slider 

• Change the View Option to 3D 

• Set the Stages slider to 7 by sliding the pointer, as 
shown, to the seventh mark. The comment 
should state ‘7 stage(s)’ 

Step 3 

Setting the Fold Sequence 

• Change the View Option to Construction 

• We are now going to select each box Section 
individually and assign a Fold Sequence 
number. We will number the Main Panels to 
fold 1st and then the bottom Dust Flaps 2nd and 
so forth. 

• Double left click on each of the sections one at 
a time and set the Fold Sequence slider the 
number of ticks from the left to correspond to the number in image Step 1.  

Image in Step 1 shows an Active Section (highlighted in blue) with the number 4 allocated. The 
image in Step 3 shows the Fold Sequence marker set at 4th tick. 

http://www.printtocut.com/help/SAi%20Box%20and%20Display_Tutorial_102.mp4
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Step 4 

Illustrate Box with Flexi 

Now we will illustrate the box. To do this we need to give Flexi the cutting instructions, which is a DXF in 
2D line view with cutting and creasing instructions. 

1. Send to Flexi by clicking the Send Box. 

Close the BD Property Inspector, using the top right X or minimize. 

2. You can create your own design (see Chapter 7) or Import using the on the Standard Toolbar 
artwork.  

3. Here we have imported artwork and added some stars.  

 

 

Step 5 

View in SAi Box Display 

• Then click on the eye  icon to ‘View in SAi Box Display’. 

• You will see the resulting placement of artwork using the 3D 
View Option. 
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Step 6 

Fold and Position Illustrated Box 
• In the Properties window, Folding Control, as shown below, move the Fold % slider to the right 

to fold.  

• Notice that the Main Sections that we previously set Fold Sequence to ‘1’ folds first. 

 
 

Then the Dust Flaps (set to Fold Sequence ‘2’) will fold. Then Fold Sequence 3 to 7. 

 

Step 7 

Preview Pane Focus and Navigation 

Move the mouse cursor to the preview pane and left click. This moves the mouse focus to the 
preview pane. Navigate the 3D box with the following mouse movements. In 3D preview… 

• Pan: Hold Left and Right mouse buttons and drag to pan in any direction.  

• Zoom: Use mouse wheel to zoom ( ) or Right click, hold and move mouse up & down on the screen   

 if necessary left click on the pane first to get mouse and keyboard focus.  
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• Rotate: Left click and drag to rotate the image (in centre to rotate out of the viewing pane, around 
the edge to rotate in the viewing pane)  

 
 
See the end of Tutorial 103 for more on Fold Sequence. 
 

Send to Flexi and Save File 

The next tutorial will use this design, so save your file for future use. 
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FreeForm Tutorial 103 - Add Flaps and Glue tabs 

In this tutorial, we will add Glue Flaps and Folding Flaps to the cardboard box created in Chapter 7. 

Tutorial Video  Add Flaps and Glue Tabs 

Step 1 

View in Sai Box and Display 

• Open 01+ cube.fs that we saved in the Chapter 5 of this manual (or open from website) 

• Use the “eye”  button to View in SAi Box Display 
 

Step 2 

Add Glue tab – Section Height dialog 

• Select Construction view 

• Double click on far left section to make 
‘Active’ as shown (highlighted in blue) 

• Right click on the top line and choose 
At Line > Add Basic Flap [L > F] from 
the context menu. 

• Use ‘period’ key to open Section 
Height dialog and enter in 8mm and hit 
OK. See image right for result. 

 

Step 3 

Change Active Point Length 
We are now going to Chamfer the Glue tab by changing the Active Point length. 

• To change the LHS Active Point, left click on the Point, which as shown below left is initially 0mm. 

• In the Edit box change this to 5mm. You will see the Active Point move 5mm right as shown 
below right. 

 
 

http://www.printtocut.com/freeform/tutorialvideos/02-%20glueflap2.mp4
http://www.printtocut.com/freeform/fftutorials.htm
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• We want to change the RHS Active Point (left click on) as shown below from 200mm to 195mm 
by changing the length in edit box as shown below left OR by using the Drag Point command 
from context menu (right click) as shown below right (i.e. click and drag point) 
 

 
 
 
 

Notes on Alignment and Snap to Grid 
As noted in the text box on previous page, holding down the shift key while dragging a point will ensure 
that line is aligned, either horizontally or vertically. 

In the image, you can see that the line is too high. Snap to Grid  will correct this and create a horizontal 
line. 

• Right click on  icon to open Grid Spacing dialog, as shown, and change from 5mm (shown 
below left) to 1mm (shown below right) to help with aligning.  

 
 
 

Step 4 

Copy Section to Clipboard and Paste 
 
Now we will copy the section using the context menu  

• Double left click on the Glue flap you just created, to make Active Section. 

• Right click to get context menu 

• Press the S key for At Section to open the fly out menu. 

• Press the C key for Copy Section to Clipboard 

 

Now we will paste a copy of the Glue flap to the bottom of the Main section 

• Double left click on the Main flap, shown below right highlighted i.e. Active Section 

• Left click on bottom line, to make Line Active 

• Use ctrl-V to paste 

  

 
Note that if you hold shift key while 
dragging, you will ensure horizontally 
aligned as per left diagram (or 
vertically aligned as the case may be)  
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Result shown right. 

 
 
 
 
 
Now repeat the paste to panel on right of Main Section as shown. 

 
 

Step 5 

Add Flaps and Chamfer 
Now add 50mm flaps  

• Double left click on the left panel  
• Use shortcut keys L > F to add flap 
• Use ‘period’ key to open Section 

Height dialog and set to 50, as shown. 

Chamfer to 15mm 

• Double left click on the panel flap 
created above 

• Use shortcut keys P > C to Chamfer 
• Use ‘period’ key to open Corner Dimension dialog and set to 15, as shown above right. 

 
Copy this to the other side and top as shown 
 

Step 6 

Fold Sequence 
As discussed in Tutorial 102, if you don’t set a fold sequence your 
box will close simultaneously.  
 
Set a simple fold sequence by double click on all three 50mm flaps 
just created, one at a time and set Fold Sequence to 2 as shown below.  
 
And then double click on the top flap, as per image above 
right, and set to Fold Sequence 3. 
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Folding Control   
The Folding Controls are only available when you are in the 3D view. Use the Amount slider or enter a 
number directly into the edit box between 0 and 100 to fold and unfold the current box template.  
 

The Play button allows you to run an animation of the box 
or display. The stages slider is used to fine-tune the speed 
of the folding. Therefore, if you want to watch the box 
Fold Stage by Stage, then tick the Stage you want Played, 
example below shows Stage 1 selected, and hit the 

 button. 
 

You will see the box slowly fold the Main Panels (1) until 
100% folded and will automatically <Stop>. Image of box 
shown. 
 

Now set tick to ‘2 stage’ and watch what happens. Then 
3 to fully close. 
 

Now try this again but tick stage to 3 and ensure Fold % 
is 0. You will see the box fold from start (flat) to finish 
(closed). 
 

Step 7 

Send to Flexi and Save File 

The next tutorial will use this design, so save your file for future use. 
Suggested file name: 02+ glueflaps.fs 
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FreeForm Tutorial 104 - Simple Scale & Stretch Modes 

In this tutorial, we will make the box that we made in Tutorial 103, double the size without altering the 
shape. Note that if your box is illustrated then this would be better achieved in your CAD program, as 
the illustrations will be scaled as well as the box. See also Chapter 4 discussion. 
 

Tutorial Video   Simple Scale Propagation  

Open 02+ glueflaps.fs that we saved in the Tutorial 103 of this manual (or open from website) 
 

Step 1 

Scale Height with Width 

If ‘Scale Ht w Wth’ is checked, the aspect ratio of the section remains constant if its width is changed. 
Otherwise the height remains 
constant if the width is changed. 

The first thing we need to do, to 
ensure that all 13 sections remain 
proportional to the increase in size. 

To do this… 

• Select each, and every, 
section in the box 
individually.  

• Tick the ‘Scale’ checkbox as 
shown. 

Ensure that you include the 
8mm Glue Flaps. 

 

Step 2 

Change stretch properties of points 

When the box is increased in size, the glue folds 
will become much straighter and the chamfers 
much smaller.  

To fix this problem we need to change the stretch 
properties of the points. 

• Select the Active Section by using click and drag, as shown below left. 

The result will be the presentation of 
arrows, which show the locking status 
pertaining to each point. 

In the image, we see that the little 
dark blue arrows, closest to the 

pointer , are locked to the top and 
left edge of the section. 

http://www.printtocut.com/freeform/tutorialvideos/03-%20scale2.mp4
http://www.printtocut.com/freeform/fftutorials.htm
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• Select the point as shown and, from the context menu, select Horizontal Stretch Mode > 
Proportional. Notice the change in all horizontal lines for the Active Section. 

 
 
 
 
 
 
 
 
 
 
 
 

• Select the same point as shown and, from the context menu, select Vertical Stretch Mode > 
Proportional.  

 
 

• Repeat this on all 3 flaps and 4 glue tabs... 
 

Step 3 

Enlarge Box 

You can now enlarge the box by changing the Base Line Width, which in this tutorial is 1400mm. 

 

 

You will notice that every section has been enlarged 
proportionally. However, the illustrations will require 
amendments to suit. 
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FreeForm Tutorial 105 – Parametric Scaling 

The Dimension Quick Entry > More button, opens a dialog box that lets you extend the use of the 1-9 
input controls. As you can see below, there is an edit box that allows you to Name the parameters for 
scaling and allows you to provide a Formula. The use of Formulas allows you to set a Section to a value 
and if the value is changed at a later time, then the Sections will change to the new value. This means 
that you can roughly create your box and later adjust the heights to achieve the desired aesthetic shape, 
as now discussed. 

Tutorial Video    Parametric Box Part 1 

In this tutorial video we are going to take a box we created in Tutorial 112 using a static method and 
turn it into a parametric design to enable the control of some of the aspects of the rivet box e.g. sizes 
etc. using controls and formulas to provide you with the ability to repurpose the box for other uses. 

First we have to assign dimensions to the different parts, enabling them to be controlled by a formula. 

Step 1 

View in SAi Box Display 

• Open 04- RivetBox1.fs from website 

• Use the “eye”  button to View in SAi Box Display 

 

Step 2 

Dimension More button 

• Select Construction View and tick the Dimensions checkbox. 

• Press the More… button as shown above to open the dialog box. 

Currently, the parameters in the Advanced Edit Properties dialog correspond to the Quick Slots 
(1-9). If you change the dimension values e.g. (1) 200 to 300mm, there will be no change to the 
sections on the box assigned the value set in Quick Slot (1). We need to create a formula. 

• Copy the Values in the Edit Properties to the Formula area → 

 

Ensure Formula values 
state unit of measure i.e. 
- if millimeters state mm, 
- if inches state in etc. 
 
 
 
 
 
 
 
 
 
Now we need to connect the Formulas to the applicable areas in the box.

http://www.printtocut.com/freeform/tutorialvideos/04-%20PM_BoxPt1.mp4
http://www.printtocut.com/freeform/fftutorials.htm
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Step 3 

Connect Values to Formulas 

• Enter descriptive names in the Value fields, as shown below, i.e. 

1. BoxHt = 300mm 
2. FlapHt = 145mm 
3. LidHt = 75mm 
4. Add BoxDep = 300mm 

Note that after you click OK to close the Dialog, the Dimension 
Quick Entry slots are changed to the descriptive value names. 

 

 

 

The diagram right, is numbered to represent the different 
panels and flap i.e. 2 are Flaps etc. 

 
 
 

Step 4 

Apply Formula to Sections  
Forced Parameter (1) 

1. Select (double click to make Active) each of the four 

sections shown with  one at a time and … 

o Right click to get context menu  

o Select At Section and Adjust Section Height 

2. Drag out using mouse past width, as shown, and press 

1 to apply Formula dimension and left click mouse. 

As we are applying the same height of 300mm to each section 
it seems that there is no change. To test that your changes 
have worked, simply change the Formula value in the 
‘Advanced Edit Properties’ from 300mm to say 400mm. All 
related sections should change to the new 400mm size. 

Step 5 

Apply Formula to All Sections 

• Repeat Step 3 for all other numbered sections in the diagram. 
Ensure you test that these are working as expected. 

Note that even though the sections are changing in size the chamfers, rivet holes etc. are not. 

The next tutorial and video will explain how to correct this. 
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Tutorial Video    Parametric Box Part 2 

After checking that parametric scaling is correctly working for each section, we will now deal with other 
elements of the box so that they will change in proportion to the new dimensions. 

In the previous tutorial, we discussed Simple Scale & Stretch Mode. The following uses what we learned.  

Step 6 

Proportional Stretch Mode to Chamfer 

Make the section Active, then… 

• Select points of the lid flap  indicated in the diagram by using left click and drag to right. 

• The result will be the presentation of dark blue arrows called stretch modes and they tell you 
where the point is anchored and the locking status pertaining to each point. The blue arrows 

closest to the pointer  are locked to the top and left edge of the section. 

• Select the two points as shown and, from the context menu, select Horizontal Stretch Mode > 
Proportional. You will need to zoom in on this area to select correctly. 

• Notice the change in all horizontal lines 
for the Active Section →  

 

• Select the same point as shown and, 
from the context menu, select Vertical 
Stretch Mode > Proportional.  

 

• Repeat on opposite lid flap. 

 

Step 7 

Proportional Stretch Mode to Tab 

• Select points of the lid tab  indicated 
in the diagram and repeat step 5 for 
horizontal and vertical stretch modes. 

• Repeat on opposite lid tab. 

 

 

 

http://www.printtocut.com/freeform/tutorialvideos/04-%20PM_BoxPt2.mp4
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Step 8 

Proportional Stretch Mode to Rivet 

• Repeat on all rivet holes. You can 
select multiple rivet holes, in each 
active section, at the same time. 

You can zoom in on rivet holes, as shown but it is not necessary. 

After completing the previous steps, test that when you change the dimensions of individual flaps, the 
rivet holes move proportionally to the change. 

 

Tutorial Video    Parametric Box Part 3 

In this tutorial, we are going to show you how to set it so that everything changes proportionally to width 
of your base line. 
 
To do this we need to replace the current settings with a formula that relates to the base line. 
 

Step 9 

Proportional to Base Line 
 
Replace current settings with formula i.e. BaseLineWth * current setting / base line width 

• Enter descriptive names in the Value fields, as shown below, i.e. 

1. BoxHt = BaseLineWth*300mm/300mm 
2. FlapHt = BaseLineWth*145mm/300mm 
3. LidHt = BaseLineWth*75mm/300mm 
4. BoxDep = BaseLineWth*300mm/300mm 

 

 

Test that this works i.e. change the Dimension Quick 
Entry ‘Base Line Width’ to 500mm. If an area doesn’t 
change then you may need to repeat Step 4 to 
applicable area. 

 

Step 10 

Add to User Library 

Now we will save these changes so that you can use this as a template for future use. 

Here we changed the Code Freeform to ‘RivetBox_PM’ and then clicked ‘Add to User Library’ 

 

http://www.printtocut.com/freeform/tutorialvideos/04-%20PM_BoxPt3.mp4
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FreeForm Tutorial 106 – Making Custom Flaps 

In this tutorial, we are going to make a Flap from scratch which approximates* the shape of the Dust 
Flap that can be imported from the Library (discussed further in Tutorial 
109). We will also learn about Machine Steps and how to Open/Close and 
Hide/UnHide. [Note: * exact measurements are not required in this 
tutorial]. 
 

Tutorial Video    Making Custom Flaps  

Step 1 

 View in SAi Box Display 

• Open 05- customflaps.fs  

• Use the “eye”  button to View in 
SAi Box Display 

Step 2 

Add Basic Flap 

Note: Flap and Panel are synonymous terms in the construction view 

• Right click on the Main Section (above highlighted Active) to bring up the context menu. 

• Press L > F to add a basic flap, measurement doesn’t really matter at this stage (Height of custom 
flap on left is 113.3mm. To get exact measurement use Quick Entry box. Image is 150mm) 

 

Notes on Machine Steps 
You will notice that there are two machine step components to this flap…  

1. the red border 

2. the dotted green fold line 

If you click on the top right point, as shown , 
the status bar shows that this is point 2 of the 
border i.e. Pt2_Border. 

The arrow  points to the next point in that machine step. 

If we click on each of the points on the Active Section, note that the description of the 2nd and 3rd images 
are at the same point but the 1st click on this point is the +Pt2_FoldLine and the 2nd click is +Pt4_Border. 
 

Note that the description of the last 3 points have a + in front of description i.e. +Pt2, +Pt4, +Pt1 which 
indicates that there is more than one point which can be potentially selected.  

 
These are Open Machine Steps. 

http://www.printtocut.com/freeform/tutorialvideos/05-%20custom1.mp4
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Notes on Open/Close Machine Step 

Since P2_FoldLine and Pt4_Border are both available for selection, we 
want only one candidate for selection, which is Pt4_Border. We, 
therefore, need to close the Machine Step. To do this click on the point 
as shown... 

1. click and ensure Pt2_FoldLine and then right click for menu 
select At Machine Step > Open/Close Machine Step 
 

2. click and ensure Pt4_Border and then right click for menu 
select At Machine Step > Open/Close Machine Step 
 

To see the result of this we need to hide the FoldLine. 

 

Notes on Hide/Unhide Machine Step 

To hide the FoldLine… 

• click on the point and ensure P2_FoldLine  

• right click for menu 

• select At Machine Step > Hide Machine Step 

 

Now when you click on this point, you will notice that there is only one point 
remaining for selection i.e. Pt4_Border. 

If you want to see the green dotted FoldLine again, just select 
Unhide Machine Steps from the context menu as shown → 

 

 

Notes on Coordinates 

The points are Cartesian i.e. consisting of a set of two lines intersecting each other at right angles, but 

are rotated so that the Base Line is the X-axis and the intersecting line is the Y-axis, and the point of their 
intersection is called the origin with the coordinates (0, 0). 

Note that the Global [0.0, 0.0] origin will always be determined by the Original Base Line.  

However, as in the case of the image below, the Active Section’s Fold Line becomes the Base Line. This 
determines the X coordinate. 

On the diagram, right, when a section is Active, Pt1 in Local 
mode is the origin and its Local coordinates become 
[0.0, 0.0]. The coordinates of Pt2 are X = 0mm and Y 
= 150mm (Active Point Index:2 relates to Pt2) 

Coordinate Selector 

Local Coordinate if greyed out. 

Global Coordinate if green. 

Left click to toggle between modes. 
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Step 3 

Drag Point  
Points 2 and 3 
 

We now want to make a dust flap similar to the custom shape.  
 

• Select Pt_2 and, from the context menu, select G for Drag Point and hold ‘shift’ key while 
dragging to constrain to same vertical line as before.  

• Release mouse and Left click to set point.  

 

• Select Pt_3 and, as per image, drag point. The point will look as 
if it is in mid air.  

To find out where this point is sitting, look at the x,y coordinates in local 
mode. Remember the Green FoldLine is now the Base Line and 
therefore the X Coordinate.  

You can also look at the Active Point on property inspector, as shown. 
 

Step 4 

Add Point After  

As per the image below, do the following… 

1. Select Pt_4 and drag point to approximate position as shown in fig.1. (Ensure that the point that 
you select is Pt4_Border before dragging) 

2. Since there is no more points to drag, we now need to select ‘Add Points After’ from context 
menu. Drag to create Pt_5 to approximate position as shown in fig.2. 

 
 

There are a number of ways to set the point to an exact position, for example… 

• Drag the point and go into numeric entry mode by using the ‘period’ key. 
(see Tutorial 103 - Step 2) 

• Go into Snap to Grid mode and drag it until snap  
(see Tutorial 103 - Notes on Alignment and Snap to Grid) 

 

3. We can continue to ‘Add Points’ as shown in fig.3 but to replicate what we have created so far 
will involve a lot of measuring, so we will ‘esc’ here and ‘Mirror’ these Machine Steps. 
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Step 5 

Mirror Complete Machine Step  

• From the context menu, select ‘At Machine Step’ > ‘Mirror-complete Machine Step’ as shown. 

• The result will be a completed dust flap, shown below right. 

 
 

Step 6 

Curve Line  

The final step is to curve the two lines. 

• Select the line shown. 

• Select ‘At Line’ > ‘Curve Line’ from the 
context menu. 

• Drag the line and hit the ‘period’ key 

• You will get a dialog, from which we will use the ‘Tangent to Prev’ 
button [the curve will become 0.086 as per the dust flap on left] 

Repeat the above for the corresponding line but this time… 

• Use the ‘Tangent to Next’ button 

 

Result 
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FreeForm Tutorial 107 – Repeating Commands 

Tutorial Video    Repeating Commands using ctrl-R 
 

Repeatable commands: 
The following commands can be repeated using ctrl-R.  
Note that you can only repeats the last command executed. 
 

• Drag Point  

• Add Basic Flap  

• Paste Clipboard Section  

• Paste Clipboard Subtree  

• Add Import Section Reference  

• Chamfer Corner  

• Fillet Corner (rounded)  

• Adjust Two Arc Corner  

• Curve Line  

• Fillet with Two Arcs  

 

 
 
 
 
In this tutorial, we will start with a 300mm x 300mm square and create the following using ctrl-R. 
 

 
 
 

http://www.printtocut.com/freeform/tutorialvideos/06-%20repeating1.mp4
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Step 1 
Main Section – 300 x 300 
For this tutorial, we will start with a 300 x 300 Main Section (as shown above) 

• Open file 06- repeating.fs (or open from website) 
or  

• create by right clicking on the ‘Base Line’ and choose At Line > Add Basic Flap [L > F] from the 
context menu.  

 

Step 2 

Add Basic Flap 
Now add a flap [L > F] on one side of the Main 
Section (the dimensions are not important), then 
use the ctrl-R command to each of the 3 other sides 
to replicate, as shown.  
 
 

Step 3 

Fillet Corner (rounded) 
Now we will fillet one of the corners and repeat this to all the other corners using ctrl-R. Remember to 
make each of the sections Active before selecting the Point to be Filleted. 

 

 
 

The result will look like this. Now we will resize the top flap. 
 

Step 4 

Resize Flap 

• Select the left-hand point as shown in fig.1  

• From the context menu, select G for Drag Point and hold ‘shift’ key while dragging to constrain 
to same vertical line as before.  

• Release mouse and Left click to set point.  

• Now select each of the other 3 points and use ctrl-R to repeat as shown fig 1 to fig.4 

 
  

http://www.printtocut.com/freeform/fftutorials.htm
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Step 5 

Non-Orthogonal Direction 
If we repeat this in a non-orthogonal direction, we can still use ctrl-R and it will move the point by the 
same vector as the previous one. 

 
 

Step 6 

Fillet with Two Arcs 
Since the corners are a little messy, we will use the L > Fillet with Two Arcs command and repeat this on 
the other side, using crtl-R, to get the result as shown below right. 
 

 
 
 

https://www.bing.com/search?q=orthogonal&FORM=AWRE
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FreeForm Tutorial 108 – Curves and Fillets 

This tutorial is not only about curves and fillets but also how to create cutouts, square and circular. 
 

Tutorial Video    Curves and Fillets       

 

Step 1 

View in SAi Box Display 

• Open 07- curves.fs  (or open from website) 

• Use the “eye”  button to View in SAi Box 
Display You will be starting with a box with 
cutout as shown.  

If you cannot open the required file, don’t worry. 
Just make two rectangles, similar to the above, as we will learn to add a cutout in Step 9 of this 
tutorial. 
 

Step 2 

Snap to Grid 
See also Tutorial 103 – Notes  

• Turn on Snap to Grid  by left clicking on icon. 

Note: Right clicking on  icon will open the Grid 
Spacing dialog. 
 

Step 3 

Add Base Line for tab – Add Points After 
1. Left click on Pt2 and from context menu select Add Points After A (fig.1) 

2. Drag to right (fig.2) and left click to apply. [Tip: Hold down shift while dragging] 

3. Left click again and drag to right (fig.3) and left click to apply. Then hit ‘esc’ to complete. 

 

 

http://www.printtocut.com/freeform/tutorialvideos/07-%20curves1.mp4
http://www.printtocut.com/freeform/fftutorials.htm
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Step 4 

Curve Line 

Now we have created a Base Line for the Curve. 

• Right click Base Line and from context menu 
press L > Curve Line 

• Drag up to create curve – see step 5 
 

Step 5 

Curve tab and Change Radius 

If we drag sufficiently far enough from the base line then we get a semi-circle either on the inside (fig.1) 
or on the outside (fig.2). For this tutorial, we want a semi-circle on the outside (fig.3). 

 

To change the radius of the curve line, repeat Step 3. Note that the radius cannot be greater than the 
length of the Base Line, however, there are ways to get around that, which we will discuss later in Step 
10 of this tutorial. 

Step 6 

Add Fillet Corner (rounded) 

• Right click LHS point as shown 
(fig.1) and from context menu 
press L > R Fillet Corner 

• Drag up to create fillet (fig.2) and 
press ‘period key’ to bring up 
Corner Dimension dialog. Enter in 50mm. 

• Repeat command on RHS point using ctrl-R.  

The resulting curve is nicely tangential to the straight edges.  

If we look at this, below, in 3D View we can see the result. 
The curve is shown both inside and outside.  
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Step 7 

Tangent to Prev / Next 

In this step, we are going to produce a tangential curve automatically in two different ways. 

1) Change our initial curve (fig.1) to an inside curve that looks like fig.2, so we can illustrate affect.  

• select and right click the Curve Line to get context menu 

• select At Line L > Curve Line and use the ‘period key’ to get Arc Aspect Ratio dialog 

• press the ‘Tangent to Prev’ button (fig.3). The curve will revert to fig.1. 

 

 

2)  Again, change our initial curve so that it is no longer tangent to the 
straight part. Do this is by using G Drag Point (fig.1) to move top LHS 
point so that it roughly corresponds to image fig.2. 

• select and right click the Curve Line to get context menu 

• select At Line L > Curve Line and use the ‘period key’ to get Arc 
Aspect Ratio dialog 

• press the ‘Tangent to Next’ button and you will see that the 
curve is now tangent to the line (fig.3).  

 
 

Note: If you press ‘Tangent to Prev’ as in fig.4, you will see that you get a different result. This is because 
it is impossible to get the curve tangent to both straight lines because the distance from A to B in fig.4 
is 50 and the distance for C is 90. The next step will discuss how we can overcome this issue. 

Notes on Section Boundaries. 

You will note that as you create curves, fillets and cutouts, a light blue area will 
still be visible to define the section boundary but is not useful for selecting the 
section. It is just a convenience for construction view and is not used for 
machining purposes.
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Step 8 

Fillet with Two Arcs 

There is a special method to fix the issue described in fig.4 
above. It is a two curve fit. 

• Right click the Curve Line 

• from the context menu select At Line L > 2 Fillet 
with Two Arcs (fig.1).  

This produces a special double curved line (fig.2) which will be tangent at both ends and it also has a 
continuous tangent at the join of those two points  

Step 9 

Adjust Two Arc Corner 

Here, we have changed our double arc curve by 
using G Drag Point, so that the curve is no longer 
any good (fig.3 arrow ). Fix by.. 

• right click the point of the curve line 

shown in fig.3 , and  

• from the context menu P > T Adjust Two 
Arc Corner. The result is shown in fig.4. 

Step 10 

Add Machine Step / Hole 

See also At Line / Add Slot (Rectangular or Circular) 

a) Square Hole – to add this … 

• Right click and from the context menu, select Add 
Machine Step N > Hole. 

• Left click at required intervals, as shown below points 1-5, to form a square. Note: To constrain 
the line to last point and keep straight hold down the ‘shift’ key while creating the square. 

The 3D View shows the result. 
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b) Round Hole –change square into a circle. 

• Right click and from the context menu, 
select At Machine Step M > Round off 
Machine Step Corners. 

 

See also At Line / Add Circle or Oval Slot  
 

c) Elliptical Hole –change square into an elliptical cutout. 

• Change the square into a rectangle, as easier to convert. Otherwise would have to drag 8 points. 

o Select point 1 shown and from context menu select Drag Point G and drag. 

o Select point 2 shown and use ctrl-R to repeat drag point. 
 
 
 
 
 

• Right click and from the context menu, select At Machine Step M > Round off Machine Step 
Corners (as per Step 9b above) 

 

Step 11 

Radius Greater than Base Line 
 
In step 4 we mentioned that the radius of a curve cannot be greater 
than the length of the Base Line, however, there are ways to get 
around that. 

First, create a Rectangle 

• Right click and from the context menu, select Add Machine Step N > Hole. 

• Left click at required intervals, as per Step 10a and shown fig.1, to form a rectangle which 
protrudes outside the Active Section.  

 

Then, create an Elliptical hole 

• Right click and from the context menu, select At Machine Step M > Round off Machine Step 
Corners to create an elliptical hole as per fig.2 

 

The 3D View shows the result.  
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FreeForm Tutorial 109 – Import Predesigned Flaps 

In this tutorial, we are going to learn how to import a library flap into your custom drawing and edit the 
import to suit your requirements.  
 

Tutorial Video   Importing pre-designed flaps  

Step 1 

Create Basic Flaps 

• Create the two rectangle Flaps – see picture in Step 3 below.  

Exact measurements are not required. 
 

Step 2 

Clipboard & Imports 

• Select the Dimensions Edit Option  

• In the Clipboard & Imports section, shown right, there is a 
dropdown menu with a list of available flaps. 

• Select ‘ExtBackTuck’ for this tutorial. 
 

Step 3 

Add Import Section Reference 

• Right click the Line on the Active Main 
Section, as shown, to bring up the 
context menu. 

• Press the L key for At Line fly out menu 

• Press the M key for Add Import Section 
Reference, drag to size and left click. 

 

As you can see here the ‘ExtBackTuck’ is added, which 
has in itself, three (3) sections. Click on each of these 
sections to make Active [Top RHS of image shows middle 
section  as Active]. 

Edit Import: Each of these imported flaps comes with a 
dialog box which allows you to move various parts of the 
flaps, as appropriate. 

 

 

http://www.printtocut.com/freeform/tutorialvideos/08-%20importing1.mp4
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Step 4 

Edit Import 
• Click on ‘Edit Import’ button, shown above.  

The image right shows the unedited dialog 

• Change the Slot Height  from 18.3mm to 12mm  

• Note the change to Active section is mirrored in 
corresponding section. 

              

 

 

Important Note: You may wish, at a future time, to convert the section into construction view 
(discussed in Step 6). When you convert to construction view, you will no longer be able to Edit 
using the dialog box. It is therefore important that you ensure that all the changes you require 
have been made before converting to construction view. 

 

Step 5 

Resize Parent Section 

• Right click the Active Section for context menu 

• Press At Section S > F Adjust Section Height 

Notice that the imported Flaps will adjust in height 
to correspond, in a way envisaged by the designer 
of the flap, not in the standard construction view 
way. 

 

So, anything you have here in stretch* properties are 
arbitrary and ignored at this point. Note in the image 
above, it shows the Main Section Active and the Indicators 

grey at the bottom of the Preview Pane. 

When the imported flap section is Active and you hover       
 over the ‘No Entry’  sign it tells you that it is imported 
and cannot be edited in construction view. You will also 
find that options on the context menu will be greyed out 
(or unavailable for selection) – as per image on the right →. 

* For notes on stretch properties see Tutorial 104 
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• We can also create a copy of the ‘ExtBackTuck’, with changes that we have made, to the other 
side.  

Copy using either ctrl-C or S > C then Paste [ctrl-v] to 
other side of Main Section as shown.  

 
Step 6 

Convert to Standard Construction View 

This is a 2 step process. Remember to make all the changes you require 
before continuing. 

• Click on the ‘No Entry’  sign and you will get this message.  

Click OK to ‘Convert to local copy’ message. 
 

• Note that the ‘No Entry’  sign is still showing as the machine steps 
are still not in standard construction view form.  

Click on the ‘No Entry’ sign again and click OK to ‘Eliminate formulas’ 
message. 

If you now click on the ‘Edit Box’ you will get a 
message that the Flap cannot be unlocked, 
however, you can still Undo the 2 steps discussed 
above. Remember to Undo twice, once for each 
step. 

 

Step 7 

Make Changes to Slot 

We can now make changes to the individual slot. 

• Select Pt_1 of the Slot as shown below left in fig.1 and Drag Point as shown in fig.2. 

 
 
 
 
 
 

 

• Repeat on Pt6 as shown in fig.3. 

Notice that the changes to the slot in the first section , do not affect 
the corresponding section . This is highlighted in 3D view → where 
the box is folded. It shows the slots do not have the same shape. 

This demonstrates the reason why you need to make all changes before 
you go into construction view. 

Note: We will be using the box we have created in this tutorial in Tutorial 110 Dimensions.  

file:///C:/Users/chaz9/AppData/Roaming/Microsoft/Word/Import_section_reference%23_
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Construction View 

By converting to Construction View you now have 
the freedom to move points around anyway you 
choose. Also, all the stretch flags, by default, have 
been change in proportion.  

This means that if you resize, you will get 
proportionally sized point positions, although the 
arcs do not change curvature.  
 

Lock / Unlock  

Another way to accomplish the same thing is to use the Auto-Lock function. When you Unlock  the 
section, it will unlock imports and formula sections. This means that you will have the ability to do make 
any changes to points, without converting to Construction View. 

Left click to toggle between Lock / Unlock . 

 

However, doing this has consequences.  

 

Imported Sections 

The following are all the available sections that can be imported via the drop down menu. 
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FreeForm Tutorial 110 – Dimensions with Annotations  

This tutorial is about annotating your box using dimension and arrow machine steps. These are 
expressed in the DXF file* but do not result in cutting or folding.  
 
* A DXF file is a file format understood by many graphical packages and is generated to send to your 
machining software – refer to Tutorial 204 DXF Cutouts. 

Tutorial Video  Annotation 

Step 1 

Open File 

We will use the box that we created in tutorial 109, so either… 

• open the file you created or  

• open the ‘09- annotation.fs’ file from the 
website.  

 

Step 2 

Dimension 

To find out how long your line is... 

• right click on the line, as shown above, and  

• from the context menu, select Add Machine Step N > Dimension 

• This is 3 step process… 

1. Click somewhere above the line (exact position is not important).  

2. You will notice that as you approach the point, there will be a black line from where you 
first clicked moving with the cursor which will change to an . Left click on point (2). 

3. Now move to right to the other point (3) and right click to terminate. 

You will see the resulting dimension line and the numerical measurement. (Shown here = 300) 

 

 

 

http://www.printtocut.com/freeform/tutorialvideos/09-%20annotation.mp4
http://www.printtocut.com/freeform/fftutorials.htm
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Step 3 

Format Machine Step - Dimension 
There is also the ability to change the format of the 
machine step… 

• right click on the line, as shown, and  

• from the context menu, select At 
Machine Step M > Format Machine Step 

 
This opens a dialog box where we  

• change the Numeric Format using the drop menu 

•  as shown, to ‘%.3F’ which means 3 decimal points  

• 3 means 3 decimal points (if not an exact 
measurement – see image below) 

• Capital F – shows millimeters i.e. mm 
Small f doesn’t 
 

 
You can also change the text size and the characteristics 

of the arrows and 
whether there are 
arrows or not. 
 
If we drag the point of Active Section as shown left, the resulting 
dimension is shown to 3 decimal points i.e. 367.767mm (%.3F) 

 
 

Notes on Dimension Formatting 

 

On every dimension line you use, a label is placed along it showing how long that section of the line is. 
These labels do not usually show units, i.e. the label on a 147.29 cm dimension would just be "1472.9" 
(depending on the default Length Units you have selected), and would look like this: 

 
By using a format string, we can show a different number of decimal places or fractions and can also 
choose to display the units which is a special text code containing formatting information. 
 

Format strings must start with a % sign and must end with the letter 'F'. Using a lower-case 'f' indicates 
that units should not be displayed (this is the default), and a capital 'F' makes units visible.  
 

The general structure of a format string used here is: % [remainder] [precision] <show units> where:  

• remainder is the period  

• precision is zero or a positive integer  
• show units is either an upper or lower-case 'F' character  

The four icon buttons on the left are on/off controls used to specify and display arrows, ticks, 
stems or lines on the end of dimension lines. Note only two options are needed to control length.  

 
The edit box on the right sets the length of the arrow heads which is in real-world 
dimensions, so a typical value may be 20mm. 
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Step 4 

Dimension Multiple Lines 

We want to create multiple dimension lines but if we start at 
the far left corner, as per image, all dimensioning created after 
this will be on an angle. Also see Step 5. 

Starting at the section shown in fig.1 below… 

• right click and from the context menu, select Add Machine Step N > Dimension 

• left click – repeating 3 click process discussed in Step 2 (result will be 78.4) 

• next left click on LH point shown fig.2  (marked 2nd) below (result will be 43) 

• then left click on RH point shown fig.2  (marked 3rd) below (result will be 78.4) 

• continue to left click until you complete dimensioning (as shown fig.4)  

• right click to terminate. 

 
 

Step 5 

Dimension Formatting and Align to Axis 

As previously stated in Step 4, the angle of the dimension machine step is determined by the first two 
points selected, as shown below left. You can also see that the text is a little large, so from the context 
menu, select At Machine Step M > Format Machine Step and decrease the Text size from 4 to 2. 

 
 

We can straighten the machine step (fig.3) by… 

• select point indicated and from the context menu, use the Drag Point G command (fig.1) 

• press the ‘period key’ to open dialog (fig.2) and press ‘Align to axes’ and OK 

 
 
NB: The dimensions in fig.1 are different measurements to fig.3 but the Machine step is not changing at 
all. The reason for the difference is that you are dropping perpendiculars onto three different angled 
lines and as the dim line angle changes, so the separation of the stems change. 
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Step 6 

Point Position X,Y 
The Global symbol pointed to here, allows you to make the 
alignment to local axis if it happens to be different to the global 
ones. 
 

Step 7 

Add Label Arrow 
To add a label simply … 

• select Add Machine Step N > Label Arrow L from the 
context menu 

• left click where you want the label to go (fig.1 – 1) 

• left click where you want the arrow to go (fig.1 – 2) 
 

 
 
 
 
 
 
 

 
Note that the Main Section is Active and annotations can be added to any section of the box but still 
pertain only to the Main Section (see Notes on Annotation, next page).   
 

Step 8 

Label Arrow Formatting 

To format the arrow from the context menu, select At Machine Step M > Format Machine Step to… 

• turn Arrows On/Off (fig.1) using AB buttons 

• change the Length and Width of Arrows.  

Compare: Fig.1 Length = 20mm Width = 6 mm and Fig.2 Length = 50mm Width =15mm 

• change Label text (fig.1) to Slot A 

• change Text angle. Compare: Fig.1 90 degrees to Fig.2 29 degrees 

• change Text size  
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Notes on Annotations 

Note that the annotations only pertain to the Active section, which in Step 7 is the Main Section. 
However, you can add annotations 
to one section or individual 
sections as it makes no difference 
to their expression in the DXF file. 
 
If you select a different section 
then the annotations grey out → 
 
 

Step 9 

Send to Flexi 

Now press the ‘Send Box’ and, as you can see below, the annotations are expressed in the DXF file. 
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FreeForm Tutorial 111 – Making a Flip Up 

This tutorial is about creating flip ups which is a common feature of point of sale boxes. 
 

This is a typical flip up here with a piece cut out of an 
adjacent section which doesn’t fold down but remains 
pointing up. 

Tutorial Video  Making a Flip-Up 

 

 
 

 

Step 1 

Open File 

Open the ’10- flipup.fs’ file from the website –The following shows in Construction View. 

 

 
 

In 3D View we see that the box has the normal fold line and unfortunately the  
flip up is hidden on the back of the box. Since we do not want the flip up to 
fold, we need to make a perforation around the area we want to flip up. 
 

So, to fix that we go back into Construction View. 
 

Notes on Flip Ups 

 
It is important to note that perforations can only be done 
outside the current Active Section. 
 

http://www.printtocut.com/freeform/tutorialvideos/10-%20flipup.mp4
http://www.printtocut.com/freeform/fftutorials.htm
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Step 2 

Perforation Machine Step 

Flip ups are made with a perforation machine step.  

Remember that perforations can only be done outside the 
current Active Section, as shown. 

• Select the section shown, in the image, to make Active. 

• Right click and from the context menu, select Add Machine 
Step N > Perforation 

 
 

NB: This machine step has to have its two ends on the fold line. 
This is shown on the image on the left. There is a small fold line 
on the top and a larger fold line on the bottom. [Tip: Zoom in for 
better view] 
 

Start perforation cut out, as shown number 1. The cursor 
changes to , left click at the 2nd point and BD will automatically 
close the selection with a straight line. Continue as shown for all 
9 points for perforation. 
 

Terminate when completed at top fold line with right click. 
 
NB: You can Drag Point G later, if any of the points don’t exactly 
end up in the required position. 
 

Step 3 

Convert to Flip Up 

• Now right click on a point of the 
perforation  

• from the context menu, select At 
Machine Step M > Convert to Flip-up  

Note perforated lines change to red lines 
i.e. machine step. 

 

 

 

 

It is possible that you get an error stating that one or both points are not 
on a foldline, as shown. In this example, you can simply can Drag Point G 
but if required, to reduce the finicalness of the test, just Zoom Out.  

View in 3D to see result. 
 
See also Tutorial 205 SuperMan Flip – adding curves.
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FreeForm Tutorial 112 – Rivet Holes 

In this tutorial we are going to make a square box and add rivet holes to hold the box together. 

Tutorial Video  Rivet Holes 

 

 

If you want to skip Steps 1-6, which 

creates the box, go to the website 

and open 11- rivetholes.fs  

 

 

 

Step 1 

New FreeForm project 

• From the Flexi tool bar, select New  

• It takes a moment for the project to load. 

Step 2 

Edit Option - Materials 

• Click on the Materials check box 

• From Material Group dropdown, select Corrugated. 

• Select a B Flute as shown. 

 

Step 3 

Starting your design 

• Click on the Dimensions check box 

• Set Dimensions 

Change the Base Line Width from 300mm (default) to 
304.8mm (12inchs) 

Set Quick Entry (1) 304.8mm (2) 150.8mm (3) 76.2mm 

 

Step 4 

Create Main Panel – Basic Flap 

• Right click on the Base Line to bring up the context menu 

• Select At Line L  / Add Basic Flap F and press Quick Entry Dimension (1) 

This will create a cube i.e. flap 1 shown in diagram, next page.  

http://www.printtocut.com/freeform/tutorialvideos/11-%20rivetholes.mp4
http://www.printtocut.com/freeform/fftutorials.htm
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Step 5 

Copy this four times 

Now you just need to add 4 more flaps, of the same size.  

To achieve this, you can simply make flap 1 Active, then… 

• Ctrl+C to copy flap 1 

• select the line where you want to adhere it to and Ctrl+V to paste, 
creating flap 2 

• left click to complete flap 

Repeat for flap 3, 4 and 5 as per diagram 

 

Step 6 

Add Flap 6 

Now add a 150.8mm flap to flap (3)  

• Make flap 3 Active and ‘At Line’ / ‘Add Basic Flap’  

• Hold down Quick Entry (2) key and move your mouse left from the 
selected line and left click to complete.  

 

Step 7 

Add Rivet Hole to Flap 6 
• Select the last flap created. The status bar will display Flap_5  

• Click on ‘Snap to Grid’ and right click to open Grid Spacing edit box, as shown.  
Change the spacing to 4.8mm  

• Zoom in and since we want to make the hole relative to the flap, click on coordinates globe to 
make local (will display as greyed out) 

• Locate 20 points across and 15 points up. The image below shows what we want to achieve. 
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• Right click on preview pane and select Add Machine Step > Hole from context menu. (1) 

• An X cursor will display (2), just left click at required intervals to form a square (2 – 5).  

Snap to Grid will constrain the line to last point and keep straight but you can also Hold down 
the ‘shift’ key while creating the square. 

• When complete, right click on a machine step of square and from context menu, select ‘At 
Machine Step / Round off Machine Step Corners’ to make the rivet hole required. 

 

 

Step 8 

Copy Flap with Rivet 
• To copy, (1) make flap Active and (2) use Ctrl+C. 

• (3) make the flap that you want to add flap to Active and select line (4) and Ctrl+V to paste. 

• As shown below right, the flap is ok except that the rivet hole is in the wrong position.  

 
 

Step 9 

Mirror-reverse Machine Step 
• To move rivet hole to correct position, make left flap Active and select a machine step on hole.  

• Right click and select ‘At Machine Step / Mirror-reverse Machine Step’ 
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Step 10 

Edit Offset 
• To allow for folding, we will offset the flap by the thickness of the material. 

• Select the right flap and make Active and click on the Edit Offsets button, as shown. 

 

• In the presented dialog, select Flap/Panel from the dropdown menu that you want to offset, 
in this case, (3) Right and tick the checkbox Right as shown. 

• Repeat for left flap i.e. make left flap Active and select (2) Left and tick Left checkbox, shown. 

 
 

Step 11 

Copy the Offset Flaps 

Now we want to copy these two offset flaps to Flap_3 as shown. 

• Copy right flap and Paste on left side of Flap_3 

• Copy left flap and Paste on right side of Flap_3 
Note only one section can be active at a time.  
Diagram is only to show what we are trying to achieve. 
 

Step 12 

Offset Flap_2 and Flap_3 
Repeat Step 10 Edit Offsets for both these flaps. 

 
 
For both flaps select (4) Left/Right from dropdown menu and tick 
the Left checkbox and the Right checkbox, as shown 
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Step 13 

Add Rivet Holes to Flap 1 
Now we are going to add two rivet holes to Flap_1, in the same way 
as Step 7. 

• Make flap Active and ensure that you still have ‘Snap to 
Grid’ on. 

• Zoom in and since we want to make the hole relative to the 
flap, ensure coordinates globe is local.  

• Locate 20 points up and 15 points across as shown.  

o ‘Add Machine Step / Hole’ 

o ‘At Machine Step / Round off Machine Step Corners’ 

• Repeat rivet hole on top edge of flap, 20 points down 
and 15 points across, shown below right. 

• Copy this flap to other side to create Flap_9 with 
matching rivet holes. 
 

Step 14 

Add Basic Flap to Flap_4 

Now we will add flaps to the top panel/flap as shown. 

• Make top flap active and right click to get context  

o At Line / Add Basic Flap 

o Use Quick Entry Dimension (3) 

• Use either Copy/Paste or use Ctrl-R to repeat adding 
same size flaps as shown. 
 

Step 15 

Chamfer Corner 

Now we will chamfer the corners  

• Make flap shown active and right click to get context  

o At Point / Chamfer Corner 

o Use full stop key to open Corner Dimensions 
edit box and type in 76.2mm 

o Click on Point to Chamfer on other side and use 
Ctrl+R to repeat. 

Step 16 

Offset tabs 

Repeat Step 10 Edit Offsets for both 
corner flaps – Offset (2) Left and then (3) Right by 6.4mm  
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Step 16 

Fillet Corner (rounded) 

To fillet the corners… 

• Make flap shown active, select Point 
and right click to get context  

o At Point / Fillet Corner 

o Move cursor until you get 
required fillet 

• Select Point and use Ctrl+R to repeat 
the fillet on the other corner of same 
flap 

• Use Ctrl+R in same way on right hand corner flap. 

 

Result 

The image shows the result in 2D and 3D view respectively. 
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FreeForm Tutorial 113 – Add Tab, Notch or Slot 

In this tutorial, we will ‘Split a Machine Step’ and then add tabs, notches and slots. 

First create a 300 x 200 rectangular section and ‘Add Basic Flap’ 
with a height of 150mm.  

Then, select the top left point and either … 

•  drag the Active Point down to 50mm from bottom to 
make a sloped line  

OR  

• use the Active Point edit box to accurately place.  

 

 

 

 

Split Machine Step 

This command provides the ability to simply open up 
a machine step polyline putting a gap at a place that 
you choose. 

In many cases this split will be done automatically for 
you as part of other commands (like adding flipups or 
tabs) but occasionally you may want to split a polyline 
machine step into two pieces before further editing. 

To do this, use the ‘At Line > Split Machine Step’ from the context menu, as shown. The 'Split Machine 
Step' command breaks a machine step at a point on the active line. Two new points are added, creating 
a little gap, which is constrained to move along the active line as you move the mouse. Left click to 
complete the command. 
 

Result: The cursor is connected to the two points by a rubber band line. This allows you to change the 
size or position of the machine step by simply moving the cursor, as shown in the images below.  

 

To enter the coordinates for accurate measurement, press the ‘period / full stop’  key. This opens a 
Precision Input dialog, discussed on the next page. 
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A Precision Input dialog box provides a button to centre the machine step and dimensions of the line. 
Example shows... 

•  Total Length: 316.2mm 

•  Distance to Centre: 158.1mm 

•  Distance to Ends: 118.1mm 

•  Machine Step width: 80mm 

Use Edit boxes to change 
dimensions and hit the ‘Apply’ 
button to see changes. 

OK button will save changes and 
exit dialog. 

 

Add Tab or Notch 

A tab and/or a notch can be created in a similar way. To do 
this, use the ‘At Line > Add Tab or Notch’ from the right click 
context menu, as shown.  
 

Result: A tab will be created which can be repositioned by 
moving the cursor up or down the selected line.  
 

To open the Precision Input dialog, press the ‘period / full stop’  key. 

The only difference to the ‘Split Machine Step’ dialog discussed on the previous page is it has an added 
height edit box. 

In the example below, tab 1 was created with a width of 50mm and a height of 25mm. It was then 
positioned 40mm from the left end. 

Tab 2 was created in the same way but you will notice that the width and height of the tab is 
remembered. Every subsequent tab or notch created will be reproduced in this manner until either 
measurement is changed or the current Box&Display session is terminated.   
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A notch is created simply by changing the 
height measurement to a negative 
number.  

In the example shown, the height of tab 2 
was changed to -25mm to change it to a 
notch, which is now remembered for 
subsequent creation. 

 

 

 
 

Add Slot 

To add rectangular slots use the ‘At Line > Add Slot’ from 
the right click context menu, as shown.  

Result: A rectangular slot will be created which can be 
repositioned by moving the cursor up or down the selected 
line.  

Like the ‘Tab/Notch’ width, height and offsets are 
remembered. Every subsequent slot created will be 
reproduced in this manner until either measurement is 
changed or the current Box&Display session is terminated.   

To open the Precision Input dialog, press the ‘period / full stop’  key. 
 

This dialog, like the ‘Add Tab or 
Notch’ dialog has edit boxes to 
control width and height. 

In addition, there are three extra edit 
boxes that control the 
inner/outer/center line offsets. 

This example shows the position of 
the slot set 10mm from the selected 
line. The center line is 25mm from 
the selected line and finally the outer 
line is 40mm from the selected line. 

 

Note: These offsets all interact. It creates the extra Hole machinestep and puts it in the “-Cut” layer (or 
uses whatever you specify as _mscutlayer). 
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Add Circle or Oval Slot 

To add a Circle or Oval slot use the ‘At Line > Add Circle or Oval Slot’ from the right click context menu. 

Result: A circle/oval slot will be created which can be repositioned by moving the cursor up or down the 
selected line.  

In this example, we have created ... 

• a circle i.e. 50mm x 50mm wide 

• a slot i.e. 10mm x 50mm wide 
 

Deleting Tabs, Notches or Slots 

To delete simply select the tab, notch or slot 
by using click and drag, as shown. 

The result will be the presentation of 
arrows, which show the locking status 
pertaining to each point. 

Hit the keyboard delete button to remove the selected tab, notch or slot. 

 

Tabs, Notches and Slots can be further amended to suit. As per the example below… 

• A rectangular slot has curved ends 

• A notch has its points filleted and the line curved 

 

To see how this is done, watch Pen Holder Display - Part 6 (start at the 4 minute mark) 

 

 

Pen Holder Display 

Watch this series of videos and see how to create a pen holder with tabs, notches and slots.  

Note: The creation of the pen holder is complex but is an excellent example of the power of freeform.  

 

Video  Part 1 Design Layout   Video  Part 2 Design Layout 

Video  Part 3 Adding Slots   Video  Part 4 Adding Tabs 

Video  Part 5 Adding Holes    Video  Part 6 Final Steps 

  

http://www.printtocut.com/freeform/tutorialvideos/12-%20PHPart6F.mp4
http://www.printtocut.com/freeform/tutorialvideos/12-%20PHPart1F.mp4
http://www.printtocut.com/freeform/tutorialvideos/12-%20PHPart2F.mp4
http://www.printtocut.com/freeform/tutorialvideos/12-%20PHPart3F.mp4
http://www.printtocut.com/freeform/tutorialvideos/12-%20PHPart4F.mp4
http://www.printtocut.com/freeform/tutorialvideos/12-%20PHPart5F.mp4
http://www.printtocut.com/freeform/tutorialvideos/12-%20PHPart6F.mp4
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Video  Part 7 Adding Illustrations 

 

 

http://www.printtocut.com/freeform/tutorialvideos/12-%20PHPart7F.mp4
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Template Tutorial 200 – Create Box FEFCO 0205 

The following will create a box using a template, make some changes and then ‘Send to Flexi’. 

Remember: 

➢ Ctrl+Click to follow internal link to quickly navigate to other parts of this document. 

➢ Return from a hyperlink jump by using Alt+left-arrow [Only with Adobe] 

Step 1 

Start by opening a template 

• click on the lightning bolt  button, which allows you to use existing templates which you 
quickly and easily modify to meet your requirements.  

Browse Box Library: When you 
start from a template, you will 
see this dialog. As we want a 
supplied template, we will use 
the default ‘Standard’ library.  

View Catalog button allows 
you to access a pdf containing 
details of each template 

• Select FEFCO 0205 as shown 

• Click ‘Create’ button 

Step 2 

Construction View 

• Ensure that you are in Construction View as shown, 

so we can add a small flap to the bottom RH section 
as per image below. 

Step 3 

Select Active Section 

• In the Preview pane, double click on the 
section shown, to make Active. You will 
know it is Active as the section turns to a 
light blue color. See Chapter 6 - Notes on 
Active Section  

• The status bar will also give you 
information about the Active Section. Just 
left of blue arrow it is called ‘Sec4_B_Flap’. 

• Left click on line shown on the Active 
Section, and right click for context menu.  
 

Note: Menu options are greyed out and 

the No Entry  sign is shown in the status bar. 
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Step 4 

No Entry message 

When you hover over the ‘No Entry’ sign, as shown, you will be 
provided with a message, informing you on why the active section 
or machine step is protected from some editing commands. 

Left or right clicking the indicator usually allows the protection to be 
removed. To ‘Convert to local copy’… 

• Left click on the ‘No Entry’  sign and you will get this message.  

Click OK to ‘Convert to local copy’ message. 
 

If you are just adding things to an existing flap such as attaching another little flap as in Step 3, you only 
need to ‘Convert to local copy’.  

The No Entry Sign may still be displayed stating ‘Formula Section. 
Click to change’ but Step 5 and Step 6 can be done without clearing 
formulas. 

See Chapter 4 - Consequences 

Tutorial Video  Convert to Local to Enable Changes to Template 

 

Step 5 

Add Basic Flap – 8mm Glue tab 

Now we can add a small flap to the bottom RH section. 

• Double click on the section Sec4_B_Flap to make 
‘Active’ as shown (highlighted in blue) 

• Right click on the RHS line and choose At Line > Add 
Basic Flap [L > F] from the context menu. 

• Use ‘period’ key  to open Section Height dialog and 
enter in 8mm and hit OK.  

 Result. The black line first presented 
will change to a red line, indicating the 
resulting machine step, as shown below in 
Step 6. 

 

If you want to make amendments to more sections, such as discussed in Step 6, you must ‘Convert to 
local copy’ on all flaps that you want amend. 

 
  

file:///C:/Users/chaz9/AppData/Roaming/Microsoft/Word/Import_section_reference%23_
http://www.printtocut.com/gettingstarted/9_Convert-to-Enable-Changes-to-Template.mp4
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Step 6 

Repeat Command 

You can use ctrl-R to repeat the process on the Top Flap, Sec4_T_Flap. 

See Chapter 5 for list of Repeatable Commands.  
Note: You can only repeat the last command executed, however, you 
can ‘Convert to local’ in between. 

• Make ‘Active’ Sec4_T_Flap and ‘Convert to local’ 

NB: Only one section can be ‘Active’ at any one time. The 
diagram is only a visual reference. 

• Left click on RH line which will change to bullseye and arrow 
as shown. 

• Use ctrl-R to repeat i.e. adding 8mm flap, as shown. 
 

Step 7 

Add Machine Step - Dimension 
Dimensions can be seen in 2D or Construction View by ticking the ‘Show 
Actual Panel Dimensions’ checkbox. As shown, Edit Option ‘Dimensions’ 
must be turned on to select this.  
 
The following requires Construction View. 

To confirm the width of the flap just created, we add dimensioning – see Tutorial 110 for more details. 

Zoom in to view the Sec4_B_Flap better. 

• right click anywhere in the preview pane and from the 
context menu  

• select Add Machine Step N > Dimension, then… 

1. To position dimension line, click somewhere 
below the line (exact position is not 
important).  

2. You will notice that as you approach the point, 
there will be a black line from where you first 
clicked, moving with the cursor which will 
change to an . Left click on start point (2). 

3. Now move to right to the other point (3) and continue for all other points for measurement, 
in this case (4). Then right click to terminate. 

Annotations 

You will see the resulting dimension line and the numerical 
measurement. (Shown here = 8) 

As you can see the added dimension line is 143.7, reflecting the 
red machine line of the flap, whereas the Actual Panel 
Dimension is 150 

We now will discuss how to change the text size to make 
dimension measurements smaller to fit.  
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Step 8 

Format Machine Step 

To make the text smaller, change the 
Text Size from 4 to 2 by formatting 
the Machine Step 

• right clicking on Machine Step, 
near the dimension arrow, as 
shown. 

• from the context menu, select - At Machine Step M > Format Machine Step. 

• this will open the Dimension Formatting dialog, shown.  

• Use the Up/Down arrows to change Text Size, in this case from 4 to 2. 

See Tutorial 110 – Step 3 for more details 

Note: If you want to save this as a template for future use, you can to ‘Add to User Library’ 

Step 9 

Send to Flexi 

The box will now appear as contours in flexi.   

There are different colors, which represent different layers/cut operations. 

❖ Green lines are fold lines.  

❖ Red lines are cut lines.  
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Template Tutorial 201 – Shelves / X017 Clinton FSU 

In Box&Display there are many variations available and we will discuss the “X017 Clinton FSU” 
(FSU=Floor Standing Unit) to show you the ability to configure settings such as size, number of shelves 
etc., and some additional style options. 
 

Tutorial Video    X017 Clinton FSU  
 

Browse Standard Library: POINT OF SALE /Shelves / X017 Clinton FSU  

Shown is a 2D preview and a photo of the box after we make changes discussed in this topic. 

 

Unit Style 

Input Edit lets you alter the shape of the top front corner of the side panel – image below squared. 

DXF lets you use a DXF shape to define the shape of the side panel – difference shown below. 

* A DXF file is a file format understood by many graphical packages and is generated to 
send to your machining software – refer to Tutorial 204 DXF Cutouts. 

As shown below all other options for Back, Shelf, Toekick settings etc are the same. 

http://www.printtocut.com/templates/X017%20Clinton%20FSU%20first%20look.mp4
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Back Settings 
Extend Height – adjusts the height of the back e.g. changed from 0mm previous page to 160mm 

This becomes important when you want to display as per the photo of finished box 
on the previous page. 

Radius Top Corners – increasing from 30mm to 160mm resulting in a more rounded corner - shown. 
 

 

Back Inset – allows you to adjust the slots where 
the back panel fits in allowing you to fine tune the 
shelf depths. Shown changed from 20mm to 
90mm.  

 

Chamfer & Radius Top Front corner 
Used with Input Edit. Allows you to chamfer at different angles, and optionally radius the sharp 
corners. 
 

Examples of boxes with adjusted tops. 

 
See Sample Cutting Layouts at the end of the tutorial. 
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Shelf Settings 

Shelf Number - change the number of shelves from 
2 to 6  

Heights – either tick the ‘Equal Height’ checkbox or 
enter required individual shelf heights 

 

Toekick Settings 
The diagram shows the effects of changing the toekick settings in 2D and the final result in 3D. 
 

 
 

Support Rod Holes 

Add Holes – tick to drill-holes which are used to 
thread rods through. Rods provide extra strength 
and support for the shelves.  

Diameter – change as required to suit rods 

 
 

If your CNC machine is not able to drill these holes, then you can still print the little circles in the 
annotations layer of the design, and thus provide guide markings for manual drilling by the person 
assembling the POS. 
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Sample Cutting Layouts 
The cutting layouts here show off some variations in the chamfer angles and the radiused corners for 
each side: 
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Template Tutorial 202 – Toolpath and Fold Lines 

The diagram shows a template with a folding line (displayed in green) around the perimeter which acts 
as one strategy for cutting the foldline. 
 

 
 
To demonstrate this better, we will filter the 
machining layers (displayed in red) so that we 
only see the fold line. 

 

Machine Filters 

• Open menu, bottom RHS of preview pane, indicated by 
blue arrow, image above. 

• Untick Layers options, Cut and Info. 

• Click OK (to Apply and Close) or Apply (remains open). 

Note on Machining Options 

 

All options can be viewed or not by turning On/Off using checkboxes or buttons on the right of dialog.  

• Fold Layer– displayed in green 

• Cut Layer - machine layers displayed in red 

• Info Layer – annotations 

• Depths relates to the cut depth i.e. in the above image, the Fold cut is 1.5mm and Machine layer 
Cut is 3mm which in this case is the depth of the material. 

• Diameter relates to the drill holes if applicable. 
 

The result is the following image, which clearly 
shows a continuous foldline around the 
perimeter and three separate internal fold lines 
i.e. not joined to perimeter fold line. 

This allows for efficient machining, as explained 
on the next page. 
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Fold Allowance 

To begin, select (tick) Edit Option ‘Dimensions’ and scroll down to Fold Allowance settings  

Slot Width can be either entered manually i.e. type in 20mm or selected from the dropdown menu.  

The image below shows Panel 2 with a Top Recess of 20mm and a Slot Width of 20mm to show that the 
perimeter foldline is continuous, in a zig zag pattern for smooth fold/cut. 

 
 

Material Thickness and Panel Recess 

Now we will stagger the panels up and down, so that they can fold in a certain order and the 
thicker material can have a recess. 

There are two ways of doing this. (1) One way was 
discussed in Chapter 3 under the topic Panels, 
where you select required panels, individually, and 
then click on the Edit button to open the Edit 
Panels Properties dialog to change.  

(2) The second way is to ‘Use a Pattern’ adjust panel heights, and the ‘Use Material Thickness’ 
to recess by either using the default Material Recess, which in the diagram states 3mm, or define 
a different measurement. We will now discuss this further. 

Pattern for Panel Recess 

The default Panel to use for a Pattern is set to ‘None’. To change this, tick the box to ‘Use…’ and 
from the drop down make a selection of Panels to use.  

In this example, we will select ‘Panels 1 & 3’ which will apply 
the Material Recess (see above ‘Use Material Thickness’ is 
ticked) which is 3mm to these panels.  

Result is that the Panels selected will be staggered, as shown below left. 

To change the Recess, untick the ‘Uses Material Thickness’ and type in required recess e.g. 
20mm, shown below right. Remember, even if with the changes, the perimeter (green) toolpath 
will remain continuous. 
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Template Tutorial 203 – Sloped Shelf Displays 

In this tutorial, we will be discussing the features of the Sloped Shelf Display (F SSD). 

Tutorial Video    Floor Sloped Shelf Displays  

From the Standard Library, select POINT OF SALE/Shelves/F350SSD-6-Deep, as shown. 

 
 

Turn on ‘Dimensions’ and we will discuss the parameters. The above diagram has been labelled to aid 
discussion. 

 

Display & Product Parameters 

Display Base Height – diagram below shows the Height 
changed from 762mm to 200mm. Compare 2D with 
Construction view which has dimensions added below. 

Slot/Tab Width (60.3mm) and Gap (100mm) as shown. 

The Tongue, labelled in above diagram, are on the Top 
unit and these slip into the Slots of the Display Base. 

 

 

 

http://www.printtocut.com/templates/POS%20SlopedShelfDisplay(F%20SSD)%20Features.mp4
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Header and Skirt Heights 

The effects of changing the Header and Skirt heights, from 200mm to 0mm, can be seen in fig1 and fig2.  

Fig3 shows the Header height changed back to 200mm. 

 

Header Radius 

Turn on/tick ‘Radius Header’. 

In fig.4 the Header Height is 200mm and the radius of the Back Panel Header is 200mm. This just applies 
the radius to the corners so, since the Width is 457.2mm, you can see a flat section in the middle. This 
happens as the height of the header is below half the width of the unit. 

• Try entering 500mm in the Back 
Panel Header. You will note that 
the entered radius will 
automatically change to 200mm, as 
the software determines that the 
radius entered is larger than half 
the width. 

In fig.5 the Header Height has been 
changed to 400mm. 

• Enter 500mm again in the Back 
Panel Header. The entered radius 
will automatically change to exactly 
½ the width which is 228.6mm and 
note that there is no flat section. 

Of course, you can select a radius smaller than ½ the width, for example 80mm.  

Header Pop Out 

You can add a Pop Out, as shown here in 
Construction View.  

• Change Head Ht to 200mm 

• Untick Radius Header 

• Tick Add Pop Out 

In 3D View you can see that the header has 
popped out to the front, so that you can 
illustrate. You can also radius the header as 
shown.  



Tutorial 203 Templates   Sloped Shelf Displays 
 

  
Page 124 

Header Pop Out Radius 

The following shows how the Radius Header Top can be resized independent to the Bottom 

• In fig.1 the Radius Header Top and Bottom are both 600.1mm 

• In fig.2 the Radius Header Top has been changed to 300.1mm 

• In fig.3 the Width has been changed to 600mm 

Note that if you try and change the Radius Header Top to 200mm, you will see that the software 
will automatically convert it back to the maximum of 300mm. 

 

Shelf Parameters 

The Shelf Parameters allow you to set the ‘Number of Shelves’, ‘Height’, ‘Width’ and ‘Depth’.  

Shelf Height – change to 200mm 

Shelf Depth – the shelf is on a slope, so the sides of box 
are not as deep as the sloped shelves. Change the Depth 
to 400mm. 

Slope – is the slope of the shelves from back to front. 

Rail Height – is the height of the rail in front. Which can be increased 
to stop packages sliding off.  

Image on left shows the box in 3D, flat i.e. Folded 0%.  

Image on right has been Folded 100%, which is necessary before 
assembly, and rotated for a better view.  
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Assemble Unit 

Use the ‘Assemble Unit’ button to assemble. Note that the Unit must be 
completely folded i.e. 100% before assembly. 

The result, shown fig.1, can also be amended while you are in 3D View. 
The preview will adjust dynamically and parametrically. 

For example, turn off/untick Pop Out as shown in fig.2. 

NB: The description on the button will change alternatively from Assemble 
to Disassemble and visa versa. 

 

 

Package Parameters 

To see how we use these, go back to 2D view. 

These parameters are greyed out until you turn on/tick ‘Use product size’ 

These setting allow you to adjust the shelves 
based on the size of the packages that will be 
displayed. 

Here we can see that our packages are 76mm 
high, 49mm wide and 38mm deep. 

Also, the Number of Units show that each shelf 
has 10 packages across with a depth of 7 i.e. 70 
packages can be stored on each shelf. 

 

 

Space or Gap  

• change the Top gap from 4.8mm 
to 80mm, which will allow room 
for you to get the packages out 
from the shelf. 

• The Sides gap ensures that the 
packages are not squashed in too 
tight. 
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Template Tutorial 204 - DXF Cutouts 

The following is based on a couple of videos, showing the use of DXF cutouts in Box&Display… 

See also Tutorial 208 Box Inserts which show another use for DXF cutouts. 

 

Tutorial Video 1   DxfCutOuts1.mp4 

The first video shows the DxfCutOut unit in the POS library, set up with a “swan” 
dxf… 

Here we have a “display basket” where the two sides are in the shape of a swan→ 

 

Tutorial Video 2   DxfCutOuts2.mp4 

In the second video, we take a piece of clipart from the internet for a Rocking Horse which we will 
bring into Flexi and select Bitmap|Vectorize|Autotrace to get a suitable RockingHorse.dxf. 

 

(1) Swan Basket Display  

From the Standard Library, select MISC – DECORATIVE / Animal / DXFCutOutDisplay, as shown. 

 
 
This is a standard DXF shape imported into Box&Display and allows you to adjust to suit. As shown in 3D, 
this DXF creates a basket effect in which you can place your products for display. 
 

http://www.printtocut.com/templates/DxfCutOuts1.mp4
http://www.printtocut.com/templates/DxfCutOuts2.mp4
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Dimensions 

The image shows the preview pane in Construction View, so as to explain the Dimensions. 

Width   – is the width of the bottom (149.2mm) plus the width of the material on both sides  
      i.e. (4.8mm x 2) + 149.2mm = 158.8mm 

Height  – is from top to bottom height 

Depth  – is from front of swan back, as shown below, dark blue dashed line. 

 

Basket Settings 

The panels that hold the Front and Back section of your basket together can 
be set to ‘Equal Heights’ by turning on/ticking the checkbox as shown 
above. Turn off/untick ‘Equal Heights’ to set independent heights. The 
image on the right shows the ‘Front Height’ remains at 179.4mm but the 
‘Back Height’ has been reset to 90mm. The number of tabs on the Back 
panel reduces to one but the number of slots remain the same. However, 
since a skin is left by over the slot, see discussion below, this will not matter. 

Height Off The Bottom – relates to the height of the slot from the bottom. 
To illustrate the setting has been changed to 40mm in the image on right. 

Basket Depth – is the distance from the outside edge of the slots, shown green dash line. 

Basket Center X – is the wherever you want the center of the part to be, which is the center of the Basket 
Depth. Using the global coordinates, we can see that the distance from the 0.0 coordinate to the end of 

the Active Section, denoted by the cursor , is 621.2 and if you move the cursor along, 349.3 will be 
approximately where the X is shown. 
See Tutorial 106 -Notes on Coordinates 

 

Slots  

The slots are created using a machine step called a ‘kiss cut’. This means that your tool will cut all the 
way thru except for the last millimetre and therefore it saves the skin on the outside. The tabs on the 
joining sections, shown above, insert into these slots. The two joining sections also have slots, in which 
the tabs of the bottom section are inserted to hold the basket together. You will need to use adhesive 
(glue) or hold together in some other manner. 
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DXF Shapes and Flip 

Select DXF – use this button to browse for dxf files saved 
on your computer – See (2) Rocking Horse Display. 

Flip – turn on/off to horizontally flip image. On the image 
right, we have turned off the Right Side and the “swans” 
are not facing the same direction. 

 

(2) Rocking Horse Display  

In the second lesson/video, we take a piece of clipart from the internet for a Rocking Horse which we 
will bring into Flexi and create a dxf.  

Tutorial Video 2   DxfCutOuts2.mp4 
 

ClipArt Imported to Flexi 

• You can get this free clipart at  http://www.allthingsclipart.com/03/rocking.horse.clipart.htm  

To save clipart to your hard drive, right click on a graphic, and then choose "save as" and select 
a location on your computer.  

• Then File > Import into Flexi.  

To get a suitable RockingHorse.dxf we need to  

• select Bitmap > Vectorize > Autotrace, shown below left.  

• Click on top left hand side of images and click and drag to select, shown below right. 

 

 

 

 

 

 

 

 

You will see the resulting shape, 
after dragging the initial image 
away, as shown below. 

 

Use Zoom Tools to select / 
increase / decrease image. 

 

Box&Display allows you to have 
dxf’s with folds or cutouts in them. 
However, you need to manage the 
cutouts so that the final cut shape 
will not have pieces falling out. 

http://www.printtocut.com/templates/DxfCutOuts2.mp4
http://www.allthingsclipart.com/03/rocking.horse.clipart.htm
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To do this we will use ‘Optimize by 3-Point Arc’ from the flyout as shown. 

Customize ClipArt for Cutout 

As stated, we need to manage the cutouts so that the final cut shape will not have pieces falling out. 

• Using the  ‘Optimize by 3-Point Arc’ tool, to select/delete unsuitable parts of image. 

Note: If you cannot find it, ensure that the Main toolbar is turned out from View > Toolbars, as shown.  

 

 

• Now save as a dxf by simply selecting File > Export, shown below left, and select a location on 
your computer. 

• Then go back to your swan by selecting the applicable Window, as shown below right. 

 

 

• then using the ‘Select DXF’ button, browse to replace the swan.dxf with the RockingHorse.dxf 

 
 



Tutorial 204 Templates   DXF Cutouts 
 

  
Page 130 

Adjust the position of the fixing slots, which you can do visually in Box&Display 

• change position of slots … 

o Height Off the Bottom 20mm 

o Basket Depth 220mm  

o Basket Center 315mm 

You are now ready to cut the final shape and assemble, as shown in 3D. 
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Template Tutorial 205 – Countertop Box and Flip Up 

In this tutorial we will create a flip up in a Point of Sale [POS*] display box.  

* where a product is passed from the seller to the customer. 

Tutorial Video    Countertop C-FL-300-2 SuperHero Flip Up 

 

When you Browse the Standard Library, you can select POINT OF SALE / Countertop /  

and either the…  

• C-FL-300 template with a cutout, 
flip up curved shape. 

• C-FL-300-2 which has a square 
top, to make your own Flip Up 
shape  

NB: The following Tutorial is similar to 
Tutorial 111 – FreeForm Flip Up 

 

 

Step 1 

Import Clipart 
 

• select from the POINT OF SALE / Countertop / C-FL-300-2 template 

• File > Import a ‘Superman’ clipart and place on pop up area, as shown below right. 

•  View in SAi Box Display, Construction View with Textures Edit Option turned on. 

• ensure that ‘Show Texture in Construction View’ is also turned on, so that you can see 
‘Superman’ image, as shown. 

 

http://www.printtocut.com/templates/Super%20Hero%20Flip%20Up.mp4
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Step 2 

Perforation Machine Step 

Flip ups are made with a perforation machine step.  

Remember that perforations can only be done outside the current Active Section, as shown. 

• Select the section shown in the image to make Active. 

• Since this is an Imported Section, click on the lock  and unlock  

See Chapter 4 Lock/Unlock for more details. 

• Right click and from the context menu, select Add Machine Step N > Perforation 

 
 

NB: This machine step has to have its two ends on the Fold Line, shown on the image below.  

Tip: Zoom in for better view 

• Start perforation cut out, as shown.  

• The cursor changes to , left click at the 2nd point and 
BD will automatically close the selection with a straight 
line. 

•  Continue as shown for all points for perforation, 
stopping at Fold Line as shown. 

• Terminate when completed at top fold line with right 
click. 

NB: You can Drag Point G and/or curve later, if any of the 
points don’t exactly end up in the required position, as 
discussed next. 
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Step 3 

Curve Line 

When we added the perforation in the last step, there were a number of lines that needed adjustment 
by changing the lines into curves to properly fit around the clipart image. To do this… 

• Left click on the line you want to adjust, to select. 

• Right click to get context menu 

• Select At Line > Curve Line as shown below 

• The cursor changes to a  and you will be able to drag 
the line out/in as shown in fig.1 / fig.2 until you get the 
result you require in fig.3.  

• Repeat for all lines that need adjustment. 

 

The result should allow for a clean cutout. 

 

 

 

Step 4 

Convert to Flip Up 

•  Now right click on a point of the perforation  

• from the context menu, select At Machine Step M > 
Convert to Flip-up  

Note perforated lines change to red lines i.e. machine 
step. 

 

 

Step 5 

Fold 

Change the View Option to 3D and use the Folding Control 
to fold. You will see something like the following images. 
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Template Tutorial 206 – Furniture Modern Shelf 

Browse the Standard Library and select FURNISHING / Furniture / Modern Shelf Unit template 

Tutorial Video    Modern Shelf 
 

 
 

Shelf Settings: 2 to 4 shelves can be selected from the dropdown menu. Field boxes allow the manual 
entering of Width, Depth, Space between shelves and the End Extn (refer diagram on the next page).  
 

Leg Settings: The following diagram show the effects of leg settings.  

Center & End Points – see Dimensions (middle of diagram), compared to settings. 

Blend Radius – see Points effected by Top, Top-Mid and Middle (on far right of diagram). Compare 
Middle Inset, shown below as 0mm, with image on the next page where the Middle Inset is 200m. 

 

 

http://www.printtocut.com/templates/Modern%20Shelf.mp4
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Blend Radius: Compare Middle Inset, shown below as 200mm, with image on the previous page where 
the Middle Inset is 0m 

 

The Bottom Arc Height is shown here as 479.4 – change this manually by typing in a smaller number 
such as 79.4mm, which will result in a straighter line.  
 

Width: Leg Width and Foot Width dimensions* are shown. 
 

 
* For more details on how to Dimension in Construction View – refer end of Chapter 1. 
 
Top Inset – the results of changing the dimension can be seen below left. 
 
Shelf End Extn - the results of changing the dimension can be seen below right. 
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Template Tutorial 207 – Furniture & Stands 

SAi Box&Display can be used to create virtually any type of package or POS 
display, including furniture.  
 

Box Wizard can be used to create your own templates. It is fast and easy to use 
with a very intuitive interface. 

Furniture 

Find more furniture box/stands under FURNISHINGS / Furniture such as the 

 X063 Dillion Table template and the  X132 Cocktail Table 
 

 

Floor Stands 

Point of Sale floor stands such as the  X101 Giraffa FSU template are also available.  
 

The template, as shown below, initially looks like a bottle as it is based on a DXF. The basic elements of 
this template can be changed to suit your specific requirements – watch the video to see how. 
 

For more details on Input Edit and DXF refer to Tutorial 201 and Tutorial 204. 
  

 
 

 

The  X106 Loxo Standee 
SIGNAGE / Floor template has 
holes in the legs that can be 
drilled to insert rods. The Hole 
Settings, however, relate to the 
ability to add a hole in the board 
e.g. shown far right.  
 

http://www.printtocut.com/templates/X063%20Dillon%20Table.mp4
http://www.printtocut.com/templates/X132%20Cocktail%20Table%20-%20Plus.mp4
http://www.printtocut.com/templates/X101%20Giraffar.mp4
http://www.printtocut.com/templates/X106%20Loxo%20Standee.mp4
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Template Tutorial 208 – Box Inserts 

A Box Insert goes inside a box when it is folded up and a DXF 
cutout can be added, as shown here in 3D. This can be useful 
if the item in the box is a specific shape. 
 

Available in library items FEFCO 0300 to 0308, 0331, 0427. 
 

Step 1 

From the Standard Library, select FEFCO/ 0300 which has optional ‘Add lid’ and ‘Insert Settings’. 

The image shows a FEFCO 300 in 2D with a lid (top right) and then an Insert was added (bottom right).  

 
 

Step 2 

For this tutorial set the Dimension to 254mm x 254mm. 
 

By default, the insert is  half of the height  of the box i.e. 
Box Dim (C) = 76.2mm and Insert Height = 38.1mm 
 

Turn off the ‘Add Lid’ option. [See Add Lid and Gap] 

Step 3  

Edit Insert  
The Edit button opens a dialog to allow you to add a dxf cutout to the insert.  

For this tutorial select the ‘Swan.dxf’. Note the DXF Size is 114.3mm before selection. 
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Result 

The DXF will be added to the insert so that you can cut it out. Fig 1 shows the cutout at 114.3mm. 

Change the DXF Size to 203.2mm (8in) which will result in Fig 2.   

 
 
Note: Whenever you add an insert to a box, it is constrained to the size of the box it sits in. The DXF size, 
in this example 203.2mm, extends to the widest or tallest point of the DXF, shown in Fig 2. 
 
Looking at this in Construction mode, (red lines are pictorially 
added for explanation only) there is a space at the top and 
bottom of the DXF cutout. This is important because you will 
want to size the DXF based on the largest dimension that will 
fit it that square, so the DXF itself will maintain the aspect 
ratio. 
 

‘Center Point (X,Y) controls allow you to change the 
position of the DXF. The example left, shows Center 
Point X changed to 90mm.  
 
Use the ‘Auto Center’ checkbox to re center. 

 

‘Gap Around Insert’ controls enable you to 
change the gap at ‘Front and Back’ (see image) 
and ‘Sides’ 

Add Lid and Gap Controls 
Use the ‘Add Lid’ checkbox to add a lid. The image below shows the folding of the box in 3D with insert 
and lid.  
 

You can also adjust the ‘Lid Gap’. The boxes below right, have a gap of 0mm and 10mm, respectively. 
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